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1. SISSEJUHATUS 
 
Õnnitleme! Olete soetanud täieliku treeningsüsteemi oma treeninguinfo vajaduse rahuldamiseks. 
Sellest kasutusjuhendist leiate informatsiooni oma jooksukompuutri maksimaalseks ärakasutamiseks. 

 
 
2. POLAR RS400 OSAD 

 
1. Jooksukompuuter Polar RS400. Jooksukompuuter registreerib ja salvestab südame löögisageduse 
ja teised treeninguandmed treeningu ajal. 
 
2. Polar WearLink® 31 vööandur. Vööandur saadab rindkerelt registreeritud signaali edasi 
jooksukompuutrile. Vööandur koosneb saatjast ja elektroodidega kummipaelast. 
 
3. Jooksu kiiruseandur Polar S1™. Andur saadab mõõdetud kiiruse/tempo ja läbitud vahemaa 
informatsiooni jooksukompuutrile. 
 
4. CD-ROM. Sellel CD-l on Polar ProTrainer 5 tarkvara ja täielik kasutusjuhend, et saaksite ära 
kasutada kõik jooksukompuutri võimalused. 
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3. KASUTAMISE ALUSTAMINE 
 
Põhiseadistused 

 
 
Enne oma jooksukompuutriga treeningute alustamist tuleb teil teha põhiseadistused. Sisestage 
andmed võimalikult täpselt, et saada korrektset tagasisidet oma tegevuse kohta treeningu ajal. 
 
Andmete muutmiseks kasutage nuppe UP ja DOWN, valiku kinnitamiseks vajutage nuppu OK. 
Näidud muutuvad kiiremini, kui vajutate ja hoiate all nuppu UP või DOWN. 
 
1. Jooksukompuutri sisselülitamiseks vajutage nuppu OK kaks korda. 
2. Ekraanile ilmub Welcome to Polar Running World!. Vajutage nuppu OK. 
3. Valige keel: English, Deutsch, Español või Français. 
4. Ekraanile ilmub Start with basic settings. Vajutage nuppu OK. 
5. Time: Valige 12h või 24h režiim. Kui valisite 12h režiimi, valige AM või PM. Seadke kellaaeg. 
6. Date: Seadke kuupäev, dd=päev, mm=kuu, yy=aasta. 
7. Units: Valige meetrilised (kg/cm/km) või anglo-ameerika (lb/ft/mi) mõõtühikud. 
8. Weight: Sisestage oma kehakaal. Kui soovite mõõtühikuid vahetada, vajutage ja hoidke all nuppu 
LIGHT. 
9. Height: Sisestage oma pikkus. Kui kasutate anglo-ameerika mõõtühikuid, sisestage kõigepealt 
pikkus jalgades (ft) ja seejärel tollides (in). 
10. Birthday: Sisestage oma sünnipäev, dd=päev, mm=kuu, yy=aasta. 
11. Sex: Sisestage sugu, Male=mees, Female=naine. 
12. Ekraanile ilmub Settings OK?. Valige Yes: seadistused kinnitatakse ja salvestatakse. 
Jooksukompuutri ekraanile ilmub kellaaeg. Valige No, kui seadistused ei ole õiged ning neid on vaja 
muuta. Vajutage nuppu STOP, et naasta selle seadistuse juurde, mida soovite muuta. 
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Menüüstruktuur 
 

 
 
4. TREENINGUKS ETTEVALMISTUMINE 
 
Vööanduri pealepanemine 
 
Südame löögisageduse mõõtmiseks tuleb kanda südame löögisageduse vööandurit. 
 
1. Niisutage jooksva vee all elektroodide ala ning veenduge, et need on läbinisti märjad. 
2. Ühendage saatja kummipaela ühe otsaga. Asetage saatjal “L” tähega märgistatud ühenduskoha 

kohale kummipaela ühendus, mis on tähistatud sõnaga “LEFT”, seejärel sulgege ühendus. 
Seadke kummipaela pikkus nii, et see oleks ümber mugavalt, kuid tihedalt. Pange vööandur 
ümber rindkere, rinnalihastest allpool ja kinnitage teine ühendus. 

3. Veenduge, et märjad elektroodid on kindlalt vastu nahka ning Polari logo saatjal on keskel ning 
õiget pidi. 

4. Selleks, et kummipael saatjast eraldada, suruge pöidla ja nimetissõrmega saatja ja kummipaela 
ühendusele ja pöörake kätt nagu näidatud joonisel. 
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Polar WearLink vööanduri saatjat on võimalik kasutada spetsiaalse riietusega, millel on 
pehmed tekstiilist elektroodid. Niisutage elektroodide ala riideesemel. Kinnitage Polar 
WearLink saatja otse riietuse külge ilma kummipaelata nii, et Polari logo saatjal oleks õiget 
pidi. 

 

 
 
Jooksu kiiruseanduri Polar S1 paigaldamine 
 
Jooksu kiiruseanduri patarei paigaldamine 
 
Enne jooksu kiiruseanduri* esmakasutust, tuleb paigaldada 
patarei (patarei sisaldub komplektis). 
 
1. Võtke lahti väike pannal ja eemaldage kahvel anduri küljest 
2. Lükake pealt must kate lükates seda kahvli otsaga (joonis 

1). 
3. Avage ettevaatlikult jooksu kiiruseanduri korpus. 

Eemaldage ettevaatlikult patareipesa jooksu kiiruseanduri 
korpusest (joonis 2) ja sisestage patarei (AAA) 
patareipessa. 

4. Sisestage patareipesa jooksu kiiruseanduri korpusesse. 
Ärge sisestamise ajal puudutage anduri korpusel 
olevat nupu tihvti. 

5. Selleks, et andur jääks veekindlaks, veenduge, et tihend on 
jäänud oma soonde. Sulgege jooksu kiiruseanduri korpus 
ja kinnitage must kate jooksu kiiruseanduri korpusele. 

6. Vajutage ja hoidke all punast nuppu anduri 
sisselülitamiseks, mille järel peaks vilkuma hakkama 
roheline tuli. Jooksu kiiruseanduri väljalülitamiseks 
vajutage ja hoidke all punast nuppu. 

7. Vanad patareid tuleb hävitada kooskõlas kohalike 
eeskirjadega. 
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Jooksu kiiruseanduri kinnitamine jalatsi paeltele 
 
Selleks, et mõõta täpselt kiirust/tempot ja läbitud vahemaad, veenduge, et jooksu kiiruseandur oleks 
paigaldatud õigesti. 
 
1. Tehke lahti väike pannal ja eemaldage kahvel 

jooksu kiiruseanduri korpuse küljest. 
2. Lõdvendage jalatsi paelu ning asetage kahvel 

nende alla, jalatsi keele peale. Pingutage 
jalatsi paelu. 

3. Asetage jooksu kiiruseanduri esiots (punase 
nupu läheduses olev ots) kahvlile ja suruge 
alla jooksu kiiruseanduri korpuse tagaosa. 
Kinnitage pannal. Veenduge, et jooksu 
kiiruseandur ei liiguks ning see on samas 
suunas teie jalaga. Mida tugevamini on andur 
kinnitatud, seda täpsem on kiiruse ja läbitud 
vahemaa mõõtmine. 

4. Lülitage treeningu eel jooksu kiiruseandur 
sisse. Vajutage punast nuppu ja hoidke seda 
all, kuni roheline tuli hakkab vilkuma. 

5. Treeningu järel lülitage jooksu kiiruseandur 
välja vajutades ja hoides all punast nuppu, 
kuni roheline tuli kustub. 

 

 
Kiiruse, tempo ja läbitud vahemaa mõõtmise täpsuse parandamiseks on võimalik andurit 
kalibreerida. Lisainfo leiate kasutusjuhendis lõigust Jooksu kiiruseanduri kalibreerimine. 

 
* Vajalik on lisavarustusena saadaolev jooksu kiiruseandur S1. 
 
Jooksu kiiruseanduri kalibreerimine 
 
Kiiruse, tempo ja läbitud vahemaa* mõõtmise täpsuse parandamiseks on võimalik andurit 
kalibreerida. Jooksu kiiruseanduri kalibreerimine on soovitatav läbi viia enne selle esmakasutamist, 
kui muudate oluliselt oma jooksustiili või kui muudate oluliselt anduri asendit jalatsil (näiteks hakkate 
kasutama uusi jooksujalatseid). Teil on võimalik andur kalibreerida läbides kindla vahemaa või 
sisestades käsitsi kalibreerimisfaktori. 
 
Jooksu kiiruseanduri kalibreerimine distantsi läbimisel (jooksev kalibreerimine) 
 
Teil on võimalik kalibreerida oma jooksu kiiruseandurit treeningu ükskõik millisel hetkel kasutades 
ringi vahemaa korrektsiooni, tingimusel, et te ei treeni vahemaal põhinevate treeningu eesmärkidega. 
Kalibreerimiseks tuleb läbida teadaoleva pikkusega distants, soovitavalt üle 1000 meetri. 
 
Veenduge, et anduri funktsioon on jooksukompuutris sisse lülitatud: 
Valige Settings > Features > Footpod. 
 
Kellaajarežiimis olles vajutage nuppu OK kaks korda, seejärel alustage jooksmist. 
 
Teil on võimalik andur kalibreerida jooksu ükskõik millisel ringil. Kui olete teadaoleva pikkusega 
distantsi alguses, vajutage nuppu OK ja alustage jooksmist. Kui olete teadaoleva pikkusega distantsi 
läbinud, kalibreerige valides ühe kahest võimalusest: 
1. Lõpetage jooksmine, seiske paigal ja vajutage ning hoidke all nuppu Light, et liikuda menüüsse 

Settings. Või, 
2. Lõpetage jooksmine, seiske paigal ja vajutage nuppu STOP üks kord. Valige Settings. 
 



 9

Valige Calibrate > Correct lap > Set true lap distance. Parandage kuvatav vahemaa näit, et see 
vastaks teadaolevale pikkusele ja vajutage nuppu OK. 
 
Ekraanile ilmub Calibration complete ja kalibreerimisfaktor. Andur on nüüd kalibreeritud ja 
kasutamiseks valmis. 
 
Kalibreerimisfaktori käsitsi sisestamine 
 
Kalibreerimisfaktor arvutatakse välja reaalse vahemaa ja kalibreerimata vahemaa suhtena. Näiteks: 
läbite 1200 m, jooksukompuutri ekraanil on näiduks 1180 m, kalibreerimisfaktor on 1.000. Uue 
kalibreerimisfaktori arvutamiseks: 1,000*1200/1180=1,017. Faktori seadmise vahemik on 0.500 kuni 
1.500. 
 
Kalibreerimisfaktori seadmiseks on neli võimalust. 
 
1. Treeningu eel. 

Valige Settings > Features > Footpod > Calibrate. 
Sisestage kalibreerimisfaktor ja vajutage nuppu OK. Andur on nüüd kalibreeritud. 

2. Südame löögisageduse mõõtmise alustamise järel, kuid enne treeningu andmete salvestamise 
alustamist. 

Kellaajarežiimis vajutage nuppu OK > Settings > Footpod > Calibrate. 
Sisestage kalibreerimisfaktor ja vajutage nuppu OK. Andur on nüüd kalibreeritud ja te võite 
alustada treeningu andmete salvestamist vajutades nuppu OK. 

3. Treeningu ajal, peatades treeningu andmete salvestamise. 
Alustage treeningut vajutades kellaajarežiimis nuppu OK kaks korda. Vajutage üks kord 
nuppu STOP ning treeningu andmete salvestamine peatub. 
Valige Settings > Calibrate > Set factor. 
Sisestage kalibreerimisfaktor ja vajutage nuppu OK. Andur on nüüd kalibreeritud. Jätkake 
treeningu andmete salvestamist vajutades nuppu OK. 

4. Treeningu ajal ilma treeningu andmete salvestamist peatamata. 
Alustage treeningut vajutades kellaajarežiimis nuppu OK kaks korda. Vajutage ja hoidke all 
nuppu LIGHT, et liikuda menüüsse Settings. 
Valige Calibration > Set factor. 
Sisestage kalibreerimisfaktor ja vajutage nuppu OK. Andur on nüüd kalibreeritud. Jätkake 
jooksmist. 

 

 
Kui ekraanile ilmub Footpod calibration failed, ei ole andur kalibreeritud ja teil tuleb proovida 
uuesti. 

 
* Vajalik on lisavarustusena saadaolev jooksu kiiruseandur S1. 
 
Treeningute plaanimine 
 
Treeningute tüübid 
 
Teil on võimalik kasutada jooksukompuutris olevaid eelseadistatud treeninguid või neid endal luua. 
Teil on võimalik koostada veelgi mitmekesisemaid treeninguid Polar ProTrainer 5 tarkvara abil ning 
need jooksukompuutrisse üle kanda. 
 
Valige Settings > Exercise. 
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Menüüst Exercise leiate te treeningute nimekirja. Teil on võimalik nimekirjas liikuda nuppude UP ja 
DOWN abil ning läbi vaadata treeninguid nupu OK abil. 

 
• Free: Ilma seadistusteta treening 
• Basic: Lihtne mõõduka intensiivsusega treening. Kestus ligikaudu 45 minutit. 
• Interval: Lihtne intervalltreening. Treening algab 15-minutilise soojendusega, millele järgneb 1-

kilomeetrine pingutusfaas ja 3-minutiline taastumisfaas, mis korduvad 5 korda. Treening lõpeb 
15-minutilise lõdvestusega. 

• OwnZone: Lihtne mõõduka intensiivsusega OwnZone-treening. Soovituslik kestus 45 minutit. 
Jooksukompuuter on võimeline automaatselt kindlaks tegema teie aeroobse (kardiovaskulaarse) 
südame löögisageduse tsooni. Seda nimetatakse OwnZone-ks. Lisainfo leiate lõigus OwnZone-
kontrollvahemiku leidmine. Taustainfo OwnZone’i kohta leiate lõigus Ownzone-treeningud. 

• Add new: Koostage ja salvestage oma isiklik treening. Jooksukompuutri mälus võib olla 10 
treeningut + 1 Free treening. 

 
Treeningu valimise järel ilmuvad ekraanile järgnevad valikud. Valige soovitud valik ja vajutage nuppu 
OK. 
 
• Select: valige treening vaikimisi treeninguks. Järgmisel korral, kui alustate treeningut, pakub 

jooksukompuuter selle treeningu vaikimisi treeninguks. 
• View: treeningu seadistuste vaatamine. Vaadake treeningu seadistused läbi nuppude UP ja 

DOWN abil: 
1. Lihtne 1-3 treeningtsooniga treening: südame löögisageduse või kiiruse/tempo* 

kontrollvahemiku piirid, kontrollvahemiku taimer/vahemaa* või 
2. Tarkvara abil koostatud treening: nimi, kirjeldus, treeningu eeldatav kestus. (Vajutage ja 

hoidke all nuppu LIGHT treeningu faaside ja valitud spordiprofiilide vaatamiseks). 
• Edit: Basic või OwnZone treeningute seadistamine vastavalt oma vajadustele. Teil on võimalik 

muuta ka teiste jooksukompuutris koostatud treeningute seadistusi. Lisainfo leiate lõigus Uute 
treeningute koostamine. Kui olete tarkvara abil loonud treeningu, mis sisaldab faase, ei ole seda 
jooksukompuutris võimalik muuta. 

• Rename: teil on võimalik ümber nimetada Basic, Interval või muu jooksukompuutris loodud 
treening. 

• Default: tehaseseadete taastamine Basic, Interval ja OwnZone treeningute jaoks. 
• Delete: teil on võimalik kustutada jooksukompuutris või tarkvara abil loodud treeningud 

jooksukompuutri mälust. 
 
Uute treeningute koostamine 
 
Uue kontrollvahemikega treeningu koostamine 
 
Teil on võimalik koostada oma isiklikke treeninguid jooksukompuutris. Mitmekesisemaid treeninguid 
on võimalik koostada Polar ProTrainer tarkvara abil. Lisainfo leiate tarkvara abifailist. 
 
Valige Settings > Exercises > Add new. 
1. Valige soovitud kontrollvahemike arv (0-3) ja vajutage nuppu OK. Kui valisite 0 

kontrollvahemikku, jätkake lõigust Uue kontrollvahemiketa treeningu koostamine. 
2. Valige kontrollvahemiku tüüp: 

A. Südame löögisageduse kontrollvahemik 
B. Kiiruse/tempo* kontrollvahemik 

Vajutage nuppu OK. Jätkake vastavalt oma valikule. 
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A. Südame löögisageduse kontrollvahemiku puhul valige kas sporditsoonid või käsitsi seatav 
kontrollvahemik. Vajutage nuppu OK. 
 
• Sport zone: Valige treeninguks üks sporditsoonidest (näiteks Z1: 50-59%). Vajutage nuppu OK. 

Polari sporditsoonid on südame löögisageduse vahemikud, mille piirid on väljendatud 
protsendina maksimaalsest südame löögisagedusest. Vaikimisi on jooksukompuutri mällu 
seadistatud viis erinevat spordisooni: väga kerge (50-59% SLSmax-st), kerge (60-69% SLSmax-st), 
mõõdukas (70-79% SLSmax-st), kõrge (80-89% SLSmax-st) ja maksimaalne (90-99% SLSmax-st). 
Vaikimisi kasutatakse vanusel põhinevat maksimaalse südame löögisageduse (SLSmax) väärtust, 
kuid kui te teate oma aeroobse ja anaeroobse läve südame löögisagedust, olete teada saanud 
eeldatava maksimaalse südame löögisageduse (HRmax-p) Polar Fitness Testi™ käigus, testinud 
oma maksimaalset südame löögisagedust ise või lasknud seda teha laboris, võite te 
sporditsoonide piire seadistada nii, et need sobiksid paremini teie treeningvajadustega. 

• Manual: Seadke ise kontrollvahemiku ülemine ja alumine piir kas löökidena minutis, protsendina 
maksimaalsest südame löögisagedusest (HR%) või protsendina südame löögisageduse 
reservist (HRR%) ja vajutage nuppu OK. 

 
Jätkake punktist 3. 
 
B. Kui valisite kiiruse/tempo* kontrollvahemiku, seadke kontrollvahemiku ülemine ja alumine piir. 
Vajutage nuppu OK. 
 
Jätkake punktist 3. 
 
3. Seadke Zone guide muutma kontrollvahemikku teatud ajavahemiku möödumisel või vahemaa* 

läbimisel. Treeningu ajal annab jooksukompuuter teile kontrollvahemiku muutumisest märku. 
• Timers: Seadke kontrollvahemiku kestus minutites ja sekundites. Vajutage nuppu OK. 
• Distances: Seadke kontrollvahemiku kestuseks vahemaa läbimine ja vajutage nuppu OK. 

Või, 
• Off: Lülitage kontrollvahemiku kestus välja ja vajutage nuppu OK. 

 
Kui te olete kindlaks määranud ühe kontrollvahemiku, ilmub ekraanile Zone 1 OK. Kui kasutusel on 
enam kui 1 kontrollvahemik, korrake tegevust nagu kirjeldatud punktides 2 ja 3 ka teiste 
kontrollvahemike jaoks. 
 
Kui treening on koostatud, ilmub ekraanile New exercise added. Uus treening (NewExe) asub 
menüüs Exercises ning te saate selle valida oma järgmiseks treeninguks. Treeningu nime 
muutmiseks valige nimekirjast Rename. 
 
Uue kontrollvahemikkudeta treeningu koostamine 
 
Kui te koostate ilma kontrollvahemikkudeta treeningu, võite te treeningu juhtimiseks kasutada 
taimereid või vahemaad*. 
 
Valige Settings > Exercises > Add new. 
1. Kontrollvahemike arv: Seadke kontrollvahemike arvuks 0. 
2. Meeldetuletuse tüüp: Seadke heliline meeldetuletus tuletamaks teile näiteks meelde kohustust 

juua teatud aja tagant (taimer) või seadke meeldetuletus korduma teatud vahemaa* järel 
(näiteks ringiaja vaatamiseks ilma ringiaega salvestamata). 

 
Taimerid 
• Taimerite arv: Seadke taimerite arv (1-3) treeningu jaoks. Vajutage nuppu OK. 
• Timer 1: Seadke taimeri kestus minutites ja sekundites ning vajutage nuppu OK. Või, 
 
Vahemaad* 
• Vahemaade arv: Valige vahemaade arv (1-3) treeningu jaoks. Vajutage nuppu OK. 
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• Distance 1: Sisestage meeldetuletuse kordumise vahemaa ja vajutage nuppu OK. 
 
Korrake punktis 2 kirjeldatut, kuni olete seadnud kõik soovitavad taimerid või vahemaad. Kui treening 
on koostatud, ilmub ekraanile New exercise added. Uus treening (NewExe) asub menüüs Exercises 
ning te saate selle valida oma järgmiseks treeninguks. Treeningu nime muutmiseks valige nimekirjast 
Rename. 
 
* Vajalik on lisavarustusena saadaolev jooksu kiiruseandur S1. 
 
5. TREENING 
 
Treeningu alustamine 
 
Kandke südame löögisageduse vööandurit ja jooksu kiiruseandurit* nagu kirjeldatud kasutusjuhendis. 
Veenduge, et jooksu kiiruseanduri kasutamine on jooksukompuutris aktiivne (Settings > Features > 
Footpod). 

 
 
1. Alustamiseks vajutage jooksukompuutri nuppu OK. 
2. 15 sekundi jooksul ilmub ekraanile teie südame löögisageduse näit. Püsige paigal ja oodake, 

kuni jooksukompuuter leiab signaali jooksu kiiruseandurilt (jooksja kujutisega sümbol lõpetab 
vilkumise). Treeningu kiireks vahetamiseks vajutage ja hoidke all nuppu UP. Kasutatava jalatsi 
info kiireks vahetamiseks vajutage ja hoidke all nuppu DOWN. 

3. Alustage treeningu andmete salvestamist vajutades nuppu OK. 
 
Teil on alternatiivselt võimalik valida Settings erinevate seadistuste vaatamiseks ja muutmiseks 
treeningu eel. Lisainfo saamiseks kõigi võimalike seadistuste kohta leiate peatükist 7. Seadistused. 
 
Settings menüüs on järgnevad valikud: 
• Exercise: Valige treening või vaadake läbi treeningu seadistused. 

Exercise: Valige Free, Basic, Interval või OwnZone. (Kui te olete ise koostanud treeninguid, 
siis ilmuvad ka need nimekirja.) 
Select: Valige treening, mida soovite kohe kasutama hakata, või 
View: Vaadake läbi treeningu seadistused. 

• Rec.rate: Salvestamissageduse seadmine. 
• TZ alarm: Kontrollvahemikust väljumise helisignaali sisse- ja väljalülitamine. 
• HR view: Valige, kas soovite südame löögisageduse näitu jälgida löökidena minutis (bpm) või 

protsendina maksimaalsest südame löögisagedusest (HR%). 
• HeartTouch: Seadke HeartTouch™ funktsioon 
• Shoes: jalatsi tähistus jalatsiga läbitud vahemaa registreerimiseks. 
• Speed view: Valige, kas soovite kiiruse* näitu jälgida kilomeetrites/miilides tunnis (km/h või 

mph) või minutites kilomeetri/miili kohta (min/km või min/mi). 
• Footpod: jooksu kiiruseanduri* funktsiooni sisse- ja väljalülitamine. 
• A.Lap: Automaatse ringiaegade registreerimise funktsiooni sisse- ja väljalülitamine. 
• Display: Ekraanile kuvatava info muutmine. Lisainfo leiate lõigus Ekraanile kuvatava info 

seadistamine treeningu ajal. 
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Kui ekraanile ilmub “(Treeningu nimetus) requires footpod. Turn footpod on?”, on treeninguks 
vajalik jooksu kiiruseanduri kasutamine kiiruse/tempo ja vahemaa* näidu registreerimiseks 
(näiteks olete te määranud kiirusel/tempol* põhineva kontrollvahemiku). Valige Yes jooksu 
kiiruseanduri funktsiooni sisselülitamiseks ja veenduge, et kasutate jooksu kiiruseandurit 
nagu kirjeldatud kasutusjuhendis. Kui ekraanile ilmub Exercise displays updated, kuvatakse 
treeningu ajal ekraanile kiiruse/tempo ja vahemaa* näidud. 

 
* Vajalik on lisavarustusena saadaolev jooksu kiiruseandur S1. 
 
Informatsioon ekraanil 
 
Treeningu ajal ekraanile ilmuv info sõltub teie poolt tehtud seadistustest. Infot ekraanil on võimalik 
muuta vajutades nuppe UP ja DOWN. Ekraanile ilmub mõneks sekundiks kuvarežiimi nimetus, mis 
vastab alumises reas kuvatavale infole. 
 
Treeningu ajal vaikimisi kuvatavad režiimid. 
 
 

 

Südame löögisageduse kuva (Heart rate) 
 
Kiirus* / Tempo* / Kalorikulu 
Stopper 
Südame löögisagedus 

 

 

Stopperi kuva (Stopwatch) 
 
Kalorikulu 
Kiirus/tempo* / Kellaaeg 
Stopper 

 

 

Ringiaja kuva (Lap time) 
 
Zone pointer 
Südame löögisagedus 
Ringiaeg 

 

 

Kiiruse/tempo* kuva (Speed/pace) 
 
Kontrollvahemik 
Vahemaa* 
Kiirus/tempo* 
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Vahemaa* kuva (Distance) 
 
Tagasilugemisega taimer 
Zone pointer 
Vahemaa 

 

 

Polar ProTrainer 5 abil koostatud treening 
 
Kui olete jooksukompuutrisse laadinud tarkvara abil koostatud programmi, 
saate jälgida treeningu andmeid eraldi kuvarežiimis. Lisainfo leiate lõigus 
Programmi kuuluva treeningu käivitamine. Teil ei ole võimalik seda 
kuvarežiimi jooksukompuutri abil muuta. 

 
Lisainfot iga kuvarežiimi muutmise kohta leiate lõigus Ekraanile kuvatava info seadistamine treeningu 
ajal. 
 
* Vajalik on lisavarustusena saadaolev jooksu kiiruseandur S1. 
 
Sümbolid ekraanil 
 
Ekraanile kuvatav 
tekst 

Sümbol Seletus 

Time of day 
 

Kellaaeg 

Countd. time või 
Countd. distance  

Tagasilugemisega taimer või vahemaa 

Lap time 
 

Ringi number ja ringiaeg 

Lap distance* 
 

Ringi number ja ringil läbitud vahemaa 

Stopwatch 
 

Treeningu kestus treeningu alustamisest 

Heart rate 
 

Hetke südame löögisagedus 

Calories 
 

Kalorikulu 

Distance* 
 

Treeningu algusest läbitud vahemaa 

Speed/pace* 
 

Hetkekiirus/hetketempo 

Zone pointer 
(südame 
löögisagedus) 

 Kontrollvahemiku indikaator, millel on 
südame sümbol, mis liigub 
kontrollvahemiku sees paremale ja 
vasakule. Kui sümbolit ei ole ekraanil 
ja/või kostub helisignaal, on teie südame 
löögisagedus väljaspool kontrollvahemiku 
piire. 
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Zone pointer 
(kiirus/tempo) 

 Kontrollvahemiku indikaator, millel on 
sümbol, mis liigub kontrollvahemiku sees 
paremale ja vasakule vastavalt teie 
kiiruse/tempo muutumisele. Kui sümbolit 
ei ole ekraanil ja/või kostub helisignaal, on 
teie kiirus/tempo väljaspool 
kontrollvahemiku piire. 

Zone pointer 
(Polari 
sporditsoonid) 

 
Kontrollvahemiku indikaator, millel on 
südame sümbol, mis liigub Polari 
sporditsoonide skaalal paremale ja 
vasakule vastavalt teie südame 
löögisageduse muutustele. Lisainfot 
sporditsooni seadmise kohta leiate lõigust 
Nuppude funktsioonid treeningu ajal. 

Target zone 

 

Graafik, mis võrdleb teie tegelikku 
südame löögisagedust võrreldes 
etteseatud kontrollvahemiku piiridega. 

 
* Vajalik on lisavarustusena saadaolev jooksu kiiruseandur S1. 
 
Nuppude funktsioonid treeningu ajal 
 
Ringiaja salvestamine 
 
 

 

Ringiaja salvestamiseks vajutage nuppu OK. Ekraanile ilmub: 
 
Ringi number 
 
Ringi keskmine südame löögisagedus 
 
Ringiaeg 

 

 

Kui kasutusel oli jooksu kiiruseandur*, ilmub ekraanile järgnev info: 
 
Ringi number 
 
Ringil läbitud vahemaa 
 
Ringi keskmine kiirus/tempo 

 
Tsooni lukustamine 
 
Kui te treenite ilma kontrollvahemikke kasutamata, võite oma südame löögisageduse lukustada 
sporditsooni, milles hetkel treenite. Nii saate te treeningu ajal määratleda kontrollvahemiku, kui te 
näiteks ei jõudnud seada kontrollvahemikku treeningu eel. 
 
Südame löögisageduse lukustamiseks sporditsooni ja selle lahtilukustamiseks vajutage ja hoidke all 
nuppu OK. 
 
Programmi kuuluvate treeningute puhul: Vajutage ja hoidke all nuppu OK ja valige Lock zone / 
Unlock zone menüüst Lap. 
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Näiteks kui treenite südame löögisagedusega 130 lööki minutis, mis on 75% teie maksimaalsest 
südame löögisageduses ja vastab sporditsoonile 3, siis võite vajutada ja hoida all nuppu OK, et 
lukustada oma südame löögisagedus tsooni 3. Ekraanile ilmub Sport zone3 Locked 70-79%. Kui 
teie südame löögisagedus väljub sporditsooni piiridest, kostub helisignaal (juhul kui 
kontrollvahemikust väljumise helisignaal on sisse lülitatud). Südame löögisageduse tsoonist 
lahtilukustamiseks vajutage ja hoidke all nuppu OK: ekraanile ilmub Sport zone3 Unlocked. 
 
Tarkvara kasutades saate seada ZoneLock funktsiooni ka kiiruse/tempo* näidule. Lisainfot leiate 
tarkvara abifailist. 
 
Ekraaniinfo suurendamine 

 
Vajutage ja hoidke all nuppu UP ülemises reas kuvatava näidu suuruse muutmiseks ja nuppu DOWN 
keskmises reas kuvatava näidu suuruse muutmiseks. Algolukorra taastamiseks vajutage ja hoidke all 
vastavat nuppu uuesti. 
 
Taustvalgustus (öörežiimi sisselülitamine) 
 
Taustvalgustuse sisselülitamiseks vajutage treeningu ajal nuppu LIGHT. Sisse lülitub öörežiim ning 
taustvalgustus lülitub sisse automaatselt, kui vajutate nuppu või muutub treeningu faas. 
 
Settings menüüsse sisenemine 
 
Vajutage ja hoidke all nuppu LIGHT > Settings. 
 
Menüü Settings ilmub ekraanile, kui vajutate ja hoiate treeningu ajal all nuppu LIGHT. Selles menüüs 
saate te teha teatud seadistusi ilma treeningu andmete salvestamist peatamata. Selles menüüs 
olevad valikud võivad muutuda sõltuvalt treeningust. Lisainfot leiate peatükist 7. Seadistused. 
 
• Prev. phase: Eelmise faasi või korduse andmete kokkuvõtte vaatamine (kuvatakse, kui kasutate 

tarkvara abil loodud faasidega treeningut). 
• Keylock: Nuppude lukustuse sisse- ja väljalülitamine juhuslike nupuvajutuste ärahoidmiseks. 
• TZ Alarm: Kontrollvahemikust väljumise helisignaali sisse- ja väljalülitamine. 
• Change zone: Kontrollvahemiku muutmine (kuvatakse vaid juhul, kui olete treeninguks seadnud 

mitu kontrollvahemikku, välja arvatud juhul, kui kasutate tarkvara abil loodud faasidega 
treeningut). 

• HR view: Südame löögisageduse näidu kuvamise valik. 
• HeartTouch: HeartTouch funktsiooni abil saate te vahetada treeningu ajal ekraanile kuvatavat 

infot ilma nuppudele vajutamata tuues jooksukompuutri vööanduril oleva Polari logo lähedale. 
• Calibrate: Jooksu kiiruseanduri* kalibreerimine (ei kuvata, kui jooksu kiiruseanduri funktsioon on 

välja lülitatud). 
• A.Lap*: Automaatse ringiaegade salvestamise sisse- ja väljalülitamine. 
 
Kui te olete vajalikud seadistused teinud, naaseb jooksukompuuter treeningrežiimi. 
 
Treeningu peatamine 
 
Treeningu andmete salvestamine on võimalik peatada vajutades nuppu STOP. 
 
Kui treeningu andmete salvestamine on peatunud, saate: 
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• Continue: jätkata andmete salvestamist. 
• Exit: Lõpetada andmete salvestamise ja treeningu lõpetada (sama, kui vajutada teist korda 

nuppu STOP). 
• Summary: Seniste treeningu andmete kuvamine kokkuvõttena. Ekraanile ilmub järgnev 

informatsioon: kalorikulu, vahemaa*, treeningu kestus, maksimaalne südame löögisagedus, 
minimaalne südame löögisagedus, keskmine südame löögisagedus, maksimaalne kiirus/tempo*, 
keskmine kiirus/tempo*, tõus ja kõrgus. 

• Settings: Teil on võimalik teha treeningu andmete salvestamise peatamisel samu seadistusi 
nagu treeningu ajal, välja arvatud ekraanile kuvatava informatsiooni muutmine. 

• Reset: Salvestatud treeninguinfo kustutamine. Valiku kinnitamiseks vajutage nuppu OK ja 
vajutage veelkord nuppu OK salvestamise taasalustamiseks. 

• Free mode: Treeningu muutmine ilma seadistusteta Free treeninguks. See valik ei kustuta 
olemasolevaid andmeid, vaid teil tekib võimalus jätkata treeningut ilma seadistusteta. Kui te 
käivitate treeningu Free, võite taaskäivitada algse treeningu, kui peatate korraks treeningu ja 
valite Restart P1. 

 
* Vajalik on lisavarustusena saadaolev jooksu kiiruseandur S1. 
 
OwnZone-kontrollvahemiku leidmine 
 
Lisainfo OwnZone® kohta leiate lõigust Ownzone-treeningud. 
 
Teil on võimalik OwnZone-kontrollvahemik leida 1-5 minuti jooksul soojenduse ajal jalgrattaga sõites 
või kõndides/joostes. Alustada tuleks madala intensiivsusega ja edaspidi treeningkoormust sujuvalt 
suurendada, et südame löögisagedus tõuseks. 
 
Leidke kontrollvahemiku piirid OwnZone’i abil uuesti, kui: 
• Muudate oma treeningukeskkonda või treeningute tüüpi. 
• Alustate treeninguid taas pärast vähemalt ühenädalast vahet. 
• Te ei ole 100-protsendiliselt kindel oma kehalises või vaimses seisundis. Näiteks, kui te ei ole 

taastunud eelmisest treeningust, ei tunne ennast hästi või teil on stress. 
• Olete vahepeal muutnud kasutajaandmeid. 
 
Veenduge, et olete enne OwnZone’i leidmist: 
• Sisestanud oma kasutajaandmed. 
• Olete sisse lülitanud OwnZone funktsiooni. Iga kord, kui alustate treeningu info salvestamist ja 

olete eelnevalt lülitanud sisse OwnZone funktsiooni, käivitub OwnZone leidmine uuesti. 
 
1. Kandke vööandurit ja jooksu kiiruseandurit* nagu kirjeldatud juhendis. Alustage mõõtmist 

vajutades nuppu OK. 
2. Kui treening käivitub, ilmub ekraanile OZ ja algab kontrollvahemiku leidmine OwnZone’i abil. 
 
Kontrollvahemiku leidmiseks OwnZone’i abil tuleb läbida kuni viis astet. Iga astme lõppemisel kuulete 
te helisignaali (kui helisignaal on sisse lülitatud), mis tähistab astme lõppemist. 
 

OZ> Kõndige väga aeglases tempos 1 minuti jooksul. Selle astme ajal peaks teie südame 
löögisagedus jääma alla 100 löögi minutis / 50% SLSmax-st.  

OZ>> Kõndige tavalises tempos 1 minuti jooksul. Suurendage selle astme jooksul sujuvalt 
oma südame löögisagedust 10-20 löögi võrra / 5% SLSmax-st. 

OZ>>> Kõndige kiires tempos 1 minuti jooksul. Suurendage selle astme jooksul sujuvalt 
oma südame löögisagedust 10-20 löögi võrra / 5% SLSmax-st. 

OZ>>>> Sörkige aeglases tempos 1 minuti jooksul. Suurendage selle astme jooksul sujuvalt 
oma südame löögisagedust 10-20 löögi võrra / 5% SLSmax-st. 

OZ>>>>> Jookske 1 minuti jooksul. Suurendage selle astme jooksul sujuvalt oma südame 
löögisagedust 10 löögi võrra / 5% SLSmax-st. 
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3. Astmete 1-5 ajal kuulete te mingil hetkel kaht helisignaali. See tähendab, et kontrollvahemik on 

OwnZone’i abil leitud. 
4. Kui OwnZone’i leidmine õnnestub, ilmub ekraanile OwnZone Updated ja kontrollvahemiku 

piiride näit. Piiride näit on kas löökidena minutis, protsendina maksimaalsest südame 
löögisagedusest (HR%) või protsendina südame löögisageduse reservist (HRR%) vastavalt teie 
eelnevatele seadistustele. 

5. Kui kontrollvahemiku leidmine OwnZone’i abil ei õnnestunud, võetakse kasutusele varem 
OwnZone’i abil leitud kontrollvahemik ning ekraanile ilmub tekst OwnZone Limits. Kui te pole 
varem OwnZone funktsiooni abil kontrollvahemiku piire leidnud, võetakse kasutusele vanusel 
põhinevad piirid. 

 
Teil on võimalik nüüd treeningut jätkata. Treeningu efektiivsuse suurendamiseks üritage hoida oma 
südame löögisagedust kontrollvahemiku piirides. Teil on võimalik kontrollvahemiku leidmine 
OwnZone’i abil katkestada ükskõik millisel hetkel vajutades nuppu OK ning kasutada varem 
OwnZone’i abil leitud kontrollvahemikku. 
 

 
OwnZone’i abil kontrollvahemiku leidmiseks kulunud aeg arvestatakse üldise treeningu 
kestuse sisse. 

 
6. TREENINGU JÄREL 
 
Treeningu lõpetamine 
 
Peatage treeningu andmete salvestamine vajutades nuppu STOP. Treeningu andmete salvestamise 
lõpetamiseks vajutage veelkord nuppu STOP. 
 
Hoolitsege vööanduri eest treeningu järel. Ühendage kummipael treeningu järel saatjast lahti. 
Hoidke vööandur kuiva ja puhtana. Lisainfot leiate lõigust Hooldus ja korrashoid. 
 
Treeningu tulemuste analüüsimine 

 
Üldise ülevaate treeningu tulemustest saate jooksukompuutri menüüst File. Andmete põhjalikumaks 
analüüsimiseks kandke need üle Polar ProTrainer 5 tarkvarasse. Tarkvara pakub teile andmete 
analüüsiks mitmesuguseid võimalusi. 
 
Ühendus jooksukompuutri ja arvuti vahel toimub IrDA infrapunaühenduse abil. Kõigepealt käivitage 
tarkvara. Seejärel seadke jooksukompuuter režiimi Connect ja asetage ta arvuti infrapunapordi 
vastu. Andmete ülekannet puudutava lisainfo leiate tarkvara abifailist. 
 
Valige File järgnevateks tegevusteks: 
• Exercise Log: Nimekiri maksimaalselt 99 failist. 
• Weekly: Kokkuvõtted viimase 16 nädala treeningutest. 
• Totals: Treeningute summaarsed näidud. 
• Delete: Treeningfailide kustutamine. 
 
Exercise Log 
 
Valige File > Exercise log. 
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Exercise Log menüüs saate te üksikasjaliku ülevaate treeningutest. Ekraanile ilmub järgnev info: 
• Treeningu nimetus. 
• Graafiline tulp, mis kujutab treeningut. Tulba kõrgus tähistab treeningu kestust. Nii saate 

graafilises formaadis esmase ülevaate oma treeningutest. 
• Treeningu toimumise kuupäev. 
 
Informatsioon, mis kuvatakse ekraanile (a-d allpool) sõltub treeningust ja seadistustest (näiteks kui 
teie treeningus ei olnud faase, siis andmeid faaside kohta ei kuvata). 
 
Liikuge treeninguid tähistavate tulpade vahel nuppude UP ja DOWN abil ja treeningu andmete 
vaatamiseks vajutage nuppu OK: 

 

a. Basic (üldinfo) 
 
Valige File > Exercise Log > Basic 

 

b. Sport zones (sporditsoonid) 
 
Valige File > Exercise Log > Sport zones 

 

c. Phases (treeningu faasid) 
 
Valige File > Exercise Log > Phases 

 

d. Laps (ringiajad) 
 
Valige File > Exercise Log > Laps 

 
a. Basic (üldinfo) 
 
Valige File > Exercise Log > Basic. 
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Treeningu nimetus 
 
Treeningu algusaeg 
 
Vahemaa* 
 
Treeningu kestus 

 
Vajutage nuppu OK ja vajutage nuppe UP või DOWN järgmise info vaatamiseks: 
 

 

Südame löögisagedus löökidena minutis vaheldumas näiduga protsendina 
maksimaalsest südame löögisagedusest. 
 
Maksimaalne südame löögisagedus 
Minimaalne südame löögisagedus 
 
Keskmine südame löögisagedus 

 

 

Kontrollvahemikud (SLS / kiirus / tempo), vaheldumisi kontrollvahemik 1, 
kontrollvahemik 2 ja kontrollvahemik 3. 
 
Ülemine piir 
 
Alumine piir 

 
 
 
 

 

Kontrollvahemikus, kontrollvahemiku ülemises piirist kõrgema ja alumisest 
piirist madalama südame löögisageduse/kiiruse/tempoga treenimise kestus, 
vaheldumisi kontrollvahemik 1, kontrollvahemik 2 ja kontrollvahemik 3 (faasid 
programmi kuuluvate treeningute puhul). 
 
Kontrollvahemikust kõrgema südame löögisageduse/kiiruse/tempoga 
treenimise kestus 
 
Kontrollvahemikust madalama südame löögisageduse/kiiruse/tempoga 
treenimise kestus 

 

 

Kiirus/tempo 
 
Maksimaalne kiirus/tempo* 
 
Keskmine kiirus/tempo 
 
Vahemaa 
Kiiruse ja tempo vahel valimiseks vajutage ja hoidke all nuppu LIGHT. 

 

Kalorikulu 
 
Treeningu ajal kulutatud energiahulk väljendab organismi pingutuse mahtu. 
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Running Index 
 
Selleks, et Running Index oleks võimalik välja arvutada, peab treening 
vastama teatud tingimustele. Lisainfot leiate lõigust Polar Running Index. 

 
Vajutage nuppu STOP üldise info kuvarežiimi naasmiseks. 
 
Lisa üldisele treeninguinfole 
 
Valige File > Exercise Log > Basic. 
 
Selleks, et lisada või kustutada lisainformatsiooni, vajutage ja hoidke all nuppu LIGHT üldise info 
kuvarežiimis. 
• Rank: Hinnake oma treeningut. 
• Feeling: Hinnake oma subjektiivset enesetunnet. 
• Temperat.: Sisestage temperatuuri näit nuppude UP ja DOWN abil. 
• Distance: Kui olete juhuslikult määranud treeninguks valed jalatsid, ja seetõttu salvestati 

vahemaa valele jalatsitele, siis siin on võimalik muuta jalatseid ja läbitud vahemaa näitu. 
Kõigepealt valige jalatsid, mida te treeningu ajal kasutasite, seejärel sisestage vahemaa näit. 
Andmed uuendatakse valitud jalatsite jaoks ning uuendatakse ka nädalase ja summaarse 
vahemaa näit. Siin on võimalik sisestada ka vahemaa, kui treenisite ilma jooksu kiiruseandurita. 
Valige Other, kui te ei soovi vahemaad seostada jalatsitega. 

 
b. Sport Zones (sporditsoonid) 

 
Valige File > Exercise Log > Sport zones. 
 
Kui olete üldise info kuvarežiimis, vajutage nuppu DOWN sporditsoonide info kuvarežiimi liikumiseks. 

 
Vajutage nuppu OK ja liikuge nuppude UP ja DOWN abil tulpade vahel sporditsoonis treenimise 
kestuse vaatamiseks. Nii näete graafilises formaadis treeningute jaotust. 
 
Vajutage nuppu STOP sporditsoonide info kuvarežiimi naasmiseks. 
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c. Phases (faasid) 

 
Valige File > Exercise Log > Phases. 
 
Menüü Phases kuvatakse vaid siis, kui treening on loodud tarkvara abil ja treening sisaldab faase. 
 
Kui olete sporditsoonide info kuvarežiimis, vajutage nuppu DOWN faaside info kuvarežiimi 
liikumiseks. Teil on võimalik vaadelda iga faasi eraldi. 
 
Üksiku faasi andmete vaatamise alustamiseks vajutage nuppu OK. Faase on võimalik võrrelda 
vajutades nuppe UP ja DOWN. 
 

 

Aeg 
 
Faasi nimetus 
 
Treeningu algusest kulunud aeg 
 
Käesoleva faasi kestus 

 

Südame löögisagedus löökidena minutis vaheldumas näiduga 
protsendina maksimaalsest südame löögisagedusest. 
 
Maksimaalne südame löögisagedus 
 
Keskmine südame löögisagedus 

 

Increased HR / Recovery HR / HR differ. 
 
Erinevus südame löögisageduse näitude vahel faasi alguses ja lõpus. 
Südame löögisagedus löökidena minutis vaheldumas näiduga 
protsendina maksimaalsest südame löögisagedusest või protsendina 
südame löögisageduse reservist. 
 
Increased HR: Kui südame löögisagedus oli madalam faasi alguses kui 
faasi lõpus, kuvatakse ekraanile südamelöökide vahe (südame 
löögisagedusest faasi lõpus lahutatakse näit faasi alguses). 
Pingutusfaasi ajal kuvab jooksukompuuter suurenenud näitu. 
 
Recovery HR: Kui südame löögisagedus oli kõrgem faasi alguses kui 
faasi lõpus, kuvatakse ekraanile südamelöökide vahe (südame 
löögisagedusest faasi alguses lahutatakse näit faasi lõpus). 
Taastumisfaasi ajal kuvab jooksukompuuter taastumise südame 
löögisageduse näitu. 
 
HR differ: Kui südame löögisagedus oli sama nii faasi alguses kui ka 
faasi lõpus, kuvab jooksukompuuter südame löögisageduse näitude 
vaheks 0. 
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Kiirus/tempo* 
 
Maksimaalne kiirus/tempo 
 
Keskmine kiirus/tempo 

 

Vahemaa* 
 
Treeningu algusest läbitud vahemaa 
 
Käesolevas faasis läbitud vahemaa 

 
Vajutage nuppu STOP faaside info kuvarežiimi naasmiseks. 
 
d. Laps (ringiajad) 
 
Valige File > Exercise Log > Laps. 
 
Kui olete faaside info kuvarežiimis, vajutage nuppu DOWN ringiaegade info kuvarežiimi liikumiseks. 
Ringiaegade info kuvatakse vaid juhul, kui mälus on enam kui üks ringiaeg. 
 

 

Salvestatud ringiaegade arv 
 
Keskmine ringiaeg 
 
Parima (lühima kestusega) ring number vaheldumisi ringiajaga 

 

 
Viimast ringaega ei kuvata kunagi parima ringiajana, isegi kui see on parim ringiaeg. Kui 
osalete võistlustel ja soovite arvesse võtta ka viimase ringi aja, vajutage finišijoone ületamisel 
nuppu OK, mitte nuppu STOP. Sellisel juhul läheb ka viimane ring parima ringiaja 
arvestusse. Finišijoone ületamise järel võite lõpetada andmete salvestamise mällu. 

 
Erinevate ringiaegade vaatamiseks vajutage nuppu OK. 
Ringiaegade võrdlemiseks vajutage nuppu UP ja DOWN. 
 
Ringiaegade lihtsamaks vaatamiseks kandke info tarkvarasse. 
 

 

Aeg 
 
Treeningu algusest kulunud aeg 
 
Ringiaeg 
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Südame löögisagedus löökidena minutis vaheldumas näiduga protsendina 
maksimaalsest südame löögisagedusest. 
 
Maksimaalne südame löögisagedus 
 
Keskmine südame löögisagedus 
 
Südame löögisagedus ringi lõpus 

 

Kiirus/tempo* 
 
Keskmine kiirus/tempo 
 
Kiirus/tempo ringi lõpus 
 
Kiiruse ja tempo vahel valimiseks vajutage ja hoidke all nuppu LIGHT. 

 

Vahemaa* 
 
Treeningu algusest läbitud vahemaa 
 
Ringi jooksul läbitud vahemaa 

 
Vajutage nuppu STOP ringiaegade info kuvarežiimi naasmiseks. 
 
* Vajalik on lisavarustusena saadaolev jooksu kiiruseandur S1. 
 
Kokkuvõte nädala treeningutest 
 
Valige File > Weekly. 

 
Kokkuvõttes nädala treeningutest näete te viimase 16 nädala treeningute kokkuvõtet. Parempoolses 
ääres olev tulp nimega This week sisaldab infot käesoleva nädala treeningute kohta. Eelnevate 
tulpade nimetuseks on sama nädala pühapäeva kuupäev. Tulpade vahel liikumiseks vajutage nuppe 
UP ja DOWN, ekraani alumises reas kuvatakse vastava nädala treeningute kestus. 

 
Valige välja soovitud nädal ja vajutage nuppu OK, et vaadata üle nädala summaarne kalorikulu, 
läbitud vahemaa* ja treeningute kestus. Vajutage nuppu DOWN sporditsoonide vaatamiseks. 
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Selleks, et näha igas sporditsoonis veedetud aega, vajutage nuppu OK ja seejärel liikuge 
sporditsoonide vahel nuppude UP ja DOWN abil. 
 
Summaarsed näidud 
 
Valige File > Totals. 
 
Summaarsed näidud sisaldavad endas mitme treeningu jooksul kogutud andmeid. Te võite kasutada 
summaarsete näitude funktsiooni iganädalaste ja/või igakuiste kokkuvõtete tegemiseks. Summaarsed 
näidud uuendatakse automaatselt hetkel, kui treening lõpetatakse. 
 
Nuppude UP ja DOWN abil saate läbi vaadata järgneva info: 
• Jalatsitega Shoes 1 või adidas abil läbitud vahemaa* 
• Jalatsitega Shoes 2 abil läbitud vahemaa* 
• Summaarne läbitud vahemaa* 
• Summaarne treeningute kestus 
• Summaarne kalorikulu näit 
• Summaarne treeningute arv 
• Väärtuste nullimine 
 
Summaarsete näitude nullimine 
 
Valige File > Totals > Reset totals. 
 
Valige nimekirjast väärtus, mida soovite nullida ja vajutage valiku kinnitamiseks nuppu OK. Nullimise 
kinnitamiseks valige Yes. Kustutatud infot ei ole võimalik enam taastada. Valige No, kui soovite 
naasta nullimise menüüsse. 
 
Failide kustutamine 
 
Valige File > Delete > Totals. 
 
Menüüs Delete on teil võimalik kustutada mälust treeninguid ühekaupa, kõik treeningu ühekorraga 
või summaarsed näidud. 
 
Nuppude UP ja DOWN abil saate läbi vaadata järgneva info: 
• Exercise: Valige kustutamiseks kindel treening. 
• All exerc.: Kustutage kõik treeningut mälust ühe nupuvajutusega. 
• Totals: Kustutage summaarsed näidud ühekaupa või kõik näidud ühekorraga. 
 
Valiku kinnitamiseks valige Yes. 
 
* Vajalik on lisavarustusena saadaolev jooksu kiiruseandur S1. 
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7. SEADISTUSED 
 
Funktsioonide seadmine 

 
 
Jooksu kiiruseandur* 
 
Jooksukompuuter pakub võimaluse jooksu kiiruseanduri* abil registreerida kiiust/tempot ja 
vahemaad. Teil on võimalik jooksu kiiruseanduri* seadistusi muuta menüüs Footpod. 
 
Lülitage kiiruse ja vahemaa funktsioon sisse ja välja. 
Valige Settings > Features > Footpod > On/Off. 
 
Kalibreerige jooksu kiiruseandur. 
Valige Settings > Features > Footpod > Calibrate. 
 
Lisainfo leiate lõigus Jooksu kiiruseanduri kalibreerimine. 
 
Salvestamissagedus 
 
Valige Settings > Features > Rec.rate > 1 / 5 / 15 / 60 sec. 
 
Jooksukompuuter on võimeline salvestama mällu teie südame löögisageduse, kiiruse/tempo* ja 
kõrguse andmeid 1-, 5-, 15- või 60-sekundilise intervalliga. Pikema intervalli kasutamisel saab mällu 
salvestada andmeid pikema perioodi kohta, lühema intervalli puhul saate südame löögisageduse ja 
teisi andmeid salvestada tihedamalt. See võimaldab täpsemat andmete analüüsi tarkvara abil. 
 
Lühema salvestusintervalli puhul täitub jooksukompuutri mälu kiiremini. Vaba salvestamisaeg 
kuvatakse salvestusintervalli valimisel ekraani alumisse ritta. Vaikimisi on salvestamissageduseks 5 
sekundit. 
 
Kui alles on vähem kui 30 minutit maksimaalses salvestamisajast, muutub salvestamise intervall 
automaatselt pikemaks (1s > 5s > 15s > 60s). See võimaldab maksimaalselt pikendada 
salvestamisaega. Kui treening lõpeb, jääb viimati kasutatud salvestamissagedus vaikimisi 
sageduseks. 
 
Allpool olev tabel tutvustab maksimaalset salvestamisaega iga salvestamissageduse jaoks. Pange 
tähele, et salvestamissagedus muutub, kui vaba salvestamisaega jääb alla 30 minuti. 
 

Kiirus/tempo*
Salvestamis-

sagedus 1 sek 
Salvestamis-

sagedus 5 sek 
Salvestamis-

sagedus 15 sek 
Salvestamis-

sagedus 60 sek 
Speed/Pace Recording Rate 1s Recording Rate 5s Recording Rate 15s Recording Rate 60s 

Off 31h 30min 158h** 474h** 1899h** 
On 7h 50min 39h 30min 94h 50min 379h** 
 
** Tegemist on kahe või enama treeningu summaga; ühe treeningu maksimaalne salvestatav kestus 
on 99 h 59 min 59 sek. Maksimaalne salvestamisaeg võib olla lühem, kui salvestatakse suur hulk 
lühikese kestusega treeninguid. 
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Tabelis näidatud salvestamisajad on hinnangulised. RR andmete salvestamisel sõltub 
salvestusaeg südame löögisagedusest ja selle vahelduvusest. Kui salvestate treeningu ajal 
ka ringiaegu ja/või kui olete tarkvara abil loonud treeningu, mis sisaldab faase, on 
maksimaalne salvestusaeg lühem. 

 
Treeningu andmete salvestamine ei peatu automaatselt, kui mälu saab täis. Seetõttu võib treeningu 
kestus olla pikem kui salvestusaeg. 
 
Jalatsid 
 
Teil on võimalik treeninguga seostada jalatsid. 
Valige Settings > Features > Shoes 1 / Shoes 2. 
 
Selleks, et jälgida ja võrrelda erinevate jalatsite kasutamist, salvestab jooksukompuuter 
jooksutreeningutel valitud jalatsitega läbitud vahemaa. 
 
Jalatsite nimetuse muutmine. 
Valige Settings > Features > Shoes 1 / Shoes 2 > Rename. 
 
Muutke nimi kasutades nuppu UP, DOWN ja OK. 
 
Teiste jalatsite kasutamine. 
Valige Settings > Features > Other. 
 
Info läbitud vahemaa kohta lisatakse vaid nädala treeningute kokkuvõttele ja summaarsetele 
näitudele ega seostata jalatsitega. 
 

 
Kui alustate treeningu andmete salvestamist, on teil võimalik lihtsalt muuta jalatseid. 
Kellaajarežiimis vajutage nuppu OK ning seejärel vajutage ja hoidke all nuppu DOWN. 
Ekraani alumises paremas nurgas olev number tähistab jalatsit. 

 
Kiiruse näidu kuvamine* 
 
Valige Settings > Features > Speed view > km/h (mph) või min/km (min/mi). 
 
Automaatne ringiaegade salvestamine* 
 
Seadke automaatne ringiaegade salvestamine. 
Valige Settings > Features > A.Lap > On > seadke vahemaa ringiaja salvestamiseks. 
 
Jooksukompuuter salvestab automaatselt ringiaja vahemaa läbimisel. Väljalülitamiseks valige Off. 
 
HeartTouch funktsiooni kasutamine 
 
Seadke HeartTouch funktsioon. 
Valige Settings > Features > HeartTouch. 
 
HeartTouch funktsioon võimaldab teil treeningu ajal kuvada ekraanile infot ilma jooksukompuutri 
nuppe vajutamata. Kui te toote jooksukompuutri vööanduril oleva logo lähedale, ilmuvad ekraanile 
kontrollvahemiku piirid. HeartTouch funktsioon on võimalik seadistama järgnevat infot: 
• Show limits: kontrollvahemiku piirid 
• Take lap: ringiaja salvestamine 
• Change view: ekraanile kuvatava info muutmine 
• Light: taustvalgustuse sisselülitamine 
• Off: HeartTouch funktsiooni väljalülitamine 
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Südame löögisageduse näidu kuvamine 
 
Valige, kuidas soovite südame löögisageduse näitu näha. 
Valige Settings > Features > HR view > HR / HR%. 
 
Sporditsoonid 
 
Seadistage enda jaoks sporditsoonid. 
Valige Settings > Features > Sport zones > sporditsooni alumine piir. 
 
Seadke nuppude UP ja DOWN abil sporditsooni 1 alumine piir. Seejärel vajutage nuppu OK. Seadke 
samamoodi alumine piir kõigi sporditsoonide jaoks. Alumise piiri seadmisel seatakse eelmise tsooni 
ülemine piir automaatselt. 
 
Vajutage ja hoidke all nuppu LIGHT, et valida, kuidas kuvatakse südame löögisageduse näit: HR% 
(protsent maksimaalsest südame löögisagedusest) või BPM (löökidena minutis). 
 

 
Teil on seadistusi võimalik lihtsalt muuta kasutades tarkvara. Lisainfo leiate tarkvara abifailist. 

 
* Vajalik on lisavarustusena saadaolev jooksu kiiruseandur S1. 
 
Kasutajaandmed 
 
Selleks, et saada täpset tagasisidet treeningu ajal, tuleb sisestada täpsed kasutajaandmed. 
 
Sisestage jooksukompuutri mällu oma kasutajaandmed. 
Valige Settings > User. 

 
 
• Weight (kehakaal): Mõõtühikute muutmiseks vajutage ja hoidke all nuppu LIGHT. 
• Height (pikkus): Mõõtühikute muutmiseks vajutage ja hoidke all nuppu LIGHT. 
• Birthday (sünnipäev): dd=päev, mm=kuu, yy=aasta 
• Sex (sugu): Male (mees) / Female (naine) 
• Activity (kehaline aktiivsus): Top (tipp) / High (kõrge) / Moderate (mõõdukas) / Low (madal) 
• Heart Rate (südame löögisagedus): HRmax (maksimaalne südame löögisagedus), HRsit (südame 

löögisagedus isteasendis) 
• VO2max: maksimaalne hapnikutarbimine 
 
Kehalise aktiivsuse tase 
 
Kehalise aktiivsuse tase on hinnang teie pikaajalisele kehalisele aktiivsusele. Valige kirjelduste seast 
selline, mis vastab enim teie kehalise aktiivsuse kestusele ja intensiivsusele viimase kolme kuu 
jooksul. 
 
• Top (tipp): Te võtate osa regulaarsest raskest kehalisest treeningust vähemalt 5 korda nädalas. 

Näiteks treenite te võistluseesmärkidel. 
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• High (kõrge): Te treenite regulaarselt vähemalt kolm korda nädalas raske kehalise koormusega. 

Näiteks jooksete te 10-40 km nädalas või tegelete vähemalt 2-4 tundi nädalas võrreldava 
kehalise aktiivsusega. 

• Moderate (mõõdukas): Tegelete regulaarselt harrastussporditreeningutega. Näiteks on teie 
nädalane jooksukilometraaž 5-10 km või te kulutate kehalisele aktiivsusele 0,5-2 tundi nädalas 
või saate mõõdukat kehalist koormust töökohal. 

• Low (madal): Te ei tegele regulaarselt harrastussporditreeninguga ega raske kehalise 
koormusega. Teete jalutuskäike vaid enda lõbuks ning harva treenite nii, et see kutsuks esile 
hingeldamise ning higistamise. 

 
Jooksukompuuter kasutab neid andmeid teie kalorikulu arvestamiseks. 
 
Südame löögisagedus: HRmax ja HRsit 
 
HRmax (maksimaalne südame löögisagedus): Vaikimisi kasutatakse vanusel põhinevat maksimaalse 
südame löögisageduse arvutust valemi 220-vanus abil. Sisestage oma HRmax, kui teil on mõõdetud 
maksimaalset südame löögisagedust laboris või olete seda ise testinud. 
 
HRsit (südame löögisagedus isteasendis): Vaikimisi kasutatakse teie vanusel põhinevat arvutust 
isteasendis südame löögisageduse leidmiseks. Sisestage oma reaalne väärtus, kui te olete selle 
kindlaks teinud vastavalt kasutusjuhendile. Lisainfo leiate lõigus Südame löögisagedus isteasendis. 
 
Maksimaalne hapnikutarbimine: VOmax 
 
VOmax on teie organismi maksimaalne võime tarbida hapnikku maksimaalse pingutuse korral. Kõige 
täpsem viis VOmax kindlaksmääramiseks on maksimaalse pingutuse testi tegemine laboris. Kui te 
teate oma kliinilise testi käigus kindlakstehtud VOmax väärtust, sisestage väärtus jooksukompuutri 
mällu. Muul juhul tuleks teil maksimaalse hapnikutarbimise näit kindlaks teha kaudselt kasutades 
Polar Fitness Testi tulemust, OwnIndexit. Lisainfo leiate lõigust Polar Fitness Test. 
 
Kui olete teinud muudatusi kasutajaandmetes, ilmub ekraanile User settings updated. 
 

 
Teil on seadistusi võimalik lihtsalt muuta kasutades tarkvara. Lisainfo leiate tarkvara abifailist. 

 
Üldseadistused 

 
 
Heli 
 
Heli seadmine. 
Valige Settings > General > Sound > Volume > On/Off. 
 
Heli seadistus puudutab nupuvajutuse helisignaali ja tegevuste helisignaali. See ei mõjuta 
kontrollvahemikust väljumise helisignaali (TZ Alarm). 
 
Kontrollvahemikust väljumise helisignaali seadmine. 
 
Valige Settings > General > Sound > TZ Alarm > On/Off. 
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Kontrollvahemikust väljumise helisignaal käivitub ning ekraanil hakkavad vilkuma kontrollvahemiku 
piirid, kui väljute kontrollvahemikust. Kui heli on välja lülitatud, kuid kontrollvahemikust väljumise 
helisignaal on sisse lülitatud, kostub kontrollvahemikust väljumisel kontrollvahemikust väljumise 
helisignaal sellegipoolest. 
 
Nuppude lukustamine 
 
Nuppude lukustamise seadistamine. 
Valige Settings > General > Keylock > Manual / Automatic. 
 
Nuppude lukustamine hoiab ära juhuslikud nupuvajutused. 
• Manual: Lülitage sisse käsitsi nuppude lukustamine. Nuppude lukustamiseks ja lukustuse 

mahavõtmiseks vajutage ja hoidke all nuppu LIGHT vähemalt 1 sekundi jooksul. 
• Automatic: Nupud lukustuvad kellaajarežiimis, kui nuppe pole vajutatud 1 minuti jooksul. 
 
Mõõtühikud 
 
Soovitud mõõtühikute valimine. 
Valige Settings > General > Units > kg/cm/km või lb/ft/mi. 
 
Keel 
 
Keele valimine. 
Valige Settings > General > Language > English / Deutsch / Español / Français. 
 
Unerežiim 
 
Unerežiimi sisselülitamine. 
Valige Settings > General > Sleep > Activate sleep mode? > Yes. 
 
Unerežiimi sisselülitamine aitab teil säästa patareisid, kui te ei kavatse jooksukompuutrit pikema aja 
jooksul kasutada. Äratuskella funktsioon toimib ka unerežiimis. 
 
Jooksukompuutri unerežiimist väljatoomine. 
 
Vajutage ükskõik millist jooksukompuutri nuppu > Turn display on? Yes / No. 
• Yes: jooksukompuutri unerežiimist väljatoomine. 
• No: jooksukompuuter naaseb unerežiimi. 
 
Teil on seadistusi võimalik lihtsalt muuta kasutades tarkvara. Lisainfo leiate tarkvara abifailist. 
 
Kellaaja seadistused 

 
 
Meeldetuletus 
 
Seadke jooksukompuuter teile meelde tuletama erinevaid sündmusi või treeninguid. 
 
Valige Settings > Watch > Reminders > Add new. 
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• Date: Sisestage meeldetuletuse kuupäev, dd=päev, mm=kuu, yy=aasta. 
• Reminder time: Sisestage meeldetuletuse kellaaeg. 
• Alarm: Seadke helisignaal kostma seatud ajal või 10 min / 30 min / 1 tund enne määratud 

tähtaega. 
• Sound: Valige helisignaali tugevus, Silent (vaikne) / Beep (piiksatus) / Normal (tavaline). 
• Repeat: Seadke meeldetuletus korduma, Once (üks kord) / Hourly (iga tunni järel) / Daily (iga 

päev) / Weekly (iga nädal) / Monthly (iga aasta) / Yearly (iga aasta). 
• Exercise: Valige treening, mida soovite seostada meeldetuletusega. Kui saabub meeldetuletuse 

tähtaeg, pakub jooksukompuuter selle treeningu välja vaikimisi treeninguna. Valige NONE, kui te 
ei soovi meeldetuletusega seostada ühtegi treeningut. 

• Rename: Meeldetuletuse ümbernimetamiseks valige tähti nuppude UP ja DOWN abil ning 
kinnitage nupu OK vajutamisega. 

 
Jooksukompuutri mällu on võimalik salvestada kuni 7 meeldetuletust. 
 
Aktiivsete meeldetuletuste vaatamine ja muutmine. 
Valige Settings > Watch > Reminders. 
 
Valige välja meeldetuletus, mida soovite vaadata, muuta või kustutada. 
 
Üritus 

 
Teil on võimalik seada päevade tagasilugemine mingi ürituseni. 
Valige Settings > Watch > Event. 
 
Event day: ürituse toimumise kuupäev, dd=päev, mm=kuu, yy=aasta. 
Rename: Ürituse ümbernimetamiseks valige tähti nuppude UP ja DOWN abil ning kinnitage nupu OK 
vajutamisega. 
 
Ürituse andmete muutmine. 
Valige Settings > Watch > Event. 
 
Teil on võimalik ürituse andmeid vaadata, seada uus ürituse toimumise aeg, üritus ümber nimetada 
või kustutada. 
 
Kellaajarežiimis on teil võimalik ürituse andmed ekraanile kuvada ning ära peita vajutades ja hoides 
all nuppu UP. 
 
Äratuskell 
 
Äratuskella seadmine. 
Valige Settings > Watch > Alarm > Off / Once / Mon-Fri / Daily. 
 
Teil on võimalik äratuskell panna äratama üks kord, iga päev esmaspäevast reedeni või iga päev. 
Äratus kostub ühe minuti jooksul või kuni nupu STOP vajutamiseni kõigis režiimides, välja arvatud 
treeningu ajal. Äratuskell toimib ka unerežiimis. Äratus kostub ka siis, kui olete heli üldseadistuste alt 
välja lülitanud. 
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Selleks, et panna äratus helisemise järel kuni 10-ks minutiks ooterežiimi, vajutage äratuskella 
helisemise ajal nuppu UP, DOWN või OK. Ekraanile ilmub Snooze ja algab äratuse taashelisemiseni 
jäänud aja tagasilugemine. Selleks, et katkestada tagasilugemine ja väljuda ooterežiimist, vajutage 
nuppu STOP. 
 

 
Kui ekraanile ilmub tühjeneva patarei sümbol, ei ole võimalik äratuskella sisse lülitada. 

 
Kellaaeg 
 
Kellaaja 1 seadmine. 
Valige Settings > Watch > Time 1 > 24h / 12h. 
 
Kellaaja 2 seadmine. 
Valige Settings > Watch > Time 2. 
Seadke vahe kellaaja 1 ja kellaaja 2 vahel tundides. 
 
Ajavööndite vahel valimine. 
Valige Settings > Watch > Time zone > Time 1 / Time 2. 
 
Valige ajavöönd. 
Kellaajarežiimis saate ajavööndite vahel valida vajutades ja hoides all nuppu DOWN. Number 2 
ekraani alumises paremas nurgas viitab sellele, et kasutusel on Kellaaeg 2. 
 
Kuupäev 
 
Kuupäeva seadmine. 
Valige Settings > Watch > Date. 
 
dd=päev, mm=kuu, yy=aasta. 
 

 
Teil on seadistusi võimalik lihtsalt muuta kasutades tarkvara. Lisainfo leiate tarkvara abifailist. 

 
Ekraanile kuvatava info seadistamine treeningu ajal 
 
Kellaajarežiimis valige OK > Settings > Display > Edit. 
 
Teil on võimalik ekraanile kuvatavat infot ümber seada vastavalt sellele, mida soovite treeningu ajal 
näha, kas otse jooksukompuutril või tarkvara kasutades. Tarkvara abil loodud programmi kuuluval 
treeningul on oma kuvarežiim, mida muuta ei ole võimalik. 
 
Lisainfot ekraanile ilmuvate sümbolite kohta leiate lõigust Informatsioon ekraanil. 
 
Valige nuppude UP ja DOWN abil välja kuvarežiim, mida soovite muuta, ja vajutage nuppu OK. 
Valige info, mida soovite kuvada vilkuvas ülemises reas nuppude UP ja DOWN abil ning vajutage 
nuppu OK. Informatsioon ekraanil sõltub funktsioonidest, mis on sisse lülitatud. Lisainfo leiate lõigust 
Funktsioonide seadmine. 
 
Korrake tegevust keskmises ja alumises reas kuvatava info valimiseks. Iga kuvarežiimi nimi vastab 
alumises reas kuvatavale infole. Kuvarežiimi tehaseseadete juurde naasmiseks vajutage ja hoidke all 
nuppu LIGHT, kui ekraanil rida vilgub. 
 
Lülitage sisse funktsioon Titles, et näha treeningu ajal kuvarežiimide vahel valides abitekste. 
Kellaajarežiimis valige OK > Settings > Display > Titles. 
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Otsetee nupp (kiirmenüü) 
 
Osa seadistusi on võimalik teha kellaajarežiimist kiirmenüü kaudu. 
Vajutage ja hoidke all nuppu LIGHT > Quick menu. 
• Keylock (nuppude lukustamine) 
• Reminders (meeldetuletused) 
• Alarm (äratuskell) 
 
 
• Time zone (ajavööndi muutmine) 
• Sleep (unerežiim) 
 
Lisainfo leiate peatükis 7. Seadistused. 
 
8. TREENINGPROGRAMM 
 
Programmi vaatamine 
 
Polar ProTrainer 5 tarkvara abil on teil võimalik koostada ja jooksukompuutrisse üle kanda isiklik 
treeningprogramm. Selles peatükis leiate informatsiooni selle kohta, kuidas liikuda programmis ja 
seda hallata jooksukompuutris. Lisainfo programmi kuuluvate treeningute tarkvara abil loomise, 
jooksukompuutrisse ülekandmise ja treeningujärgse analüüsi kohta leiate Polar ProTrainer 5 abifailist. 
 
Kui olete programmi jooksukompuutrisse laadinud, tekivad juurde kaks menüüd, milles te saate 
programmi vaadata ja kontrollida teie päevaplaani. Nädalate, päevade ja treeningute vahel 
liikumiseks kasutage nuppe UP ja DOWN. Nädala ja päeva valimiseks vajutage nuppu OK. 

 

 
 
Nädalase programmi vaatamine. 
Valige Program > Week view. 
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Nädala kuva annab ülevaate teie nädala treeningutest. Valge tulp tähistab plaanitavate treeningute 
kestust ja must tulp sooritatud treeningute kestust. Tulpade alla kuvatakse nädala treeningute 
plaanitud kestus. 
 
Vajutage ja hoidke all nuppu LIGHT järgneva nädala treeninguid puudutava info ekraanile 
kuvamiseks: 
• Week info: Nädala nimetus ja kirjeldus. 
• Targets (sihtväärtused): Nädala eesmärkide kokkuvõte. Kalorikulu, vahemaa* ja kestus. 

Erinevates sporditsoonides treenimise kestus: vajutage nuppu OK ja liikuge sporditsoonide 
vahel vajutades nuppu UP ja DOWN. 

• Results (tulemused): Nädala tulemuste kokkuvõte. Kalorikulu, vahemaa* ja kestus. Erinevates 
sporditsoonides treenimise kestus: vajutage nuppu OK ja liikuge sporditsoonide vahel vajutades 
nuppu UP ja DOWN. 

• Reminder (meeldetuletus): seadke meeldetuletuse aeg (määratud ajal, 10 minutit, 30 minutit või 
1 tund enne määratud aega) ja helisignaali tüüp (Silent=vaikne, Beep=piiksatus või 
Normal=tavaline). 

• Program off: Programmi eemaldamine jooksukompuutrist. 
 
Päevase programmi vaatamine 

 
Valige Program > Week view > Day view. 
Valige Today > Exercise view. 
 
Päeva kuva annab ülevaate teie päeva treeningutest. Valge tulp tähistab plaanitavate treeningute 
kestust ja must tulp sooritatud treeningute kestust. Tulpade alla kuvatakse päeva treeningute 
plaanitud kestus. 
 
Vajutage ja hoidke all nuppu LIGHT päeva treeninguid puudutava info ekraanile kuvamiseks: 
• Targets (sihtväärtused): Päeva eesmärkide kokkuvõte. Kalorikulu, vahemaa* ja kestus. 

Erinevates sporditsoonides treenimise kestus: vajutage nuppu OK ja liikuge sporditsoonide 
vahel vajutades nuppu UP ja DOWN. 

• Results (tulemused): Päeva tulemuste kokkuvõte. Kalorikulu, vahemaa* ja kestus. Erinevates 
sporditsoonides treenimise kestus: vajutage nuppu OK ja liikuge sporditsoonide vahel vajutades 
nuppu UP ja DOWN. 

 
Päeva treeninguinfo vaatamine 
Valige Program > Week view > Day view > Exercise view. 

 
Treeninguinfo režiimis näete te järgmist infot: treeningu nimi, kirjeldus ja sihiks seatud kestus. 
 
Vajutage ja hoidke all nuppu LIGHT järgneva info ekraanile kuvamiseks: 
• Targets (sihtväärtused): Treeningu eesmärkide kokkuvõte. Kalorikulu, vahemaa* ja kestus. 

Erinevates sporditsoonides treenimise kestus: vajutage nuppu OK ja liikuge sporditsoonide 
vahel vajutades nuppu UP ja DOWN. 
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• Phases (faasid): Treeningu faaside kokkuvõte. 
• Sport profile (spordiprofiil): Valitud spordiprofiili nimi. Lisainfot leiate tarkvara abifailist. 
• Reminder (meeldetuletus): Meeldetuletuse aja seadmine. 
 
* Vajalik on lisavarustusena saadaolev jooksu kiiruseandur S1. 
 
Programmi kuuluva treeningu käivitamine 
 
Treeningu alustamine 
 
Kui olete seadnud meeldetuletuse, annab jooksukompuuter tähtaja saabumisel märku plaanitud 
treeningust. Kui meeldetuletus ilmub ekraanile, on teil nuppu OK vajutades võimalik kontrollida infot 
plaanitud treeningu kohta. 
 
Treeningu alustamine 
Valige Today > Exercise view > Vajutage OK > Vajutage OK. 
Valige Program > Week View > Day view > Exercise view > Vajutage OK > Vajutage OK. 
 
Lisainfot treeningu andmete salvestamise kohta leiate lõigust Treeningu alustamine. 
Jooksukompuuter juhendab teid treeningu ajal. 
 
Faasidega treening 
 
Allpool on näide intervalltreeningust, mis koosneb neljast faasist. 
 
Warm up / P1: Jookske 10 minutit südame löögisagedusega 55-65% maksimaalsest. 
Interval / P2: Jookske 3 km tempoga 3:30-4:00 min/km. 
Recovery / P3: 3 km läbimise järel laske oma südame löögisagedusel taastuda 120 löögini minutis. 
Korrake faase 2 ja 3 kuus korda. 
Cool down / P4: Jookske 10 minutit tempoga 5:00-6:00 min/km. 
 
Ekraanile kuvatavad näidud 
 
Treeningu ajal näete te järgnevaid kuvasid: 
 

 
 

Iga faas algab sellega, et ekraanile kuvatakse: 
 
Faasi nimi 
 
Kontrollvahemiku tüüp 
 
Kontrollvahemiku piirid 
 
Faasi kordumise arv 

 

 

Treeningu ajal näete faasi kuvarežiimis: 
 
Tagasilugemisega taimer/vahemaa*, edasilugemisega taimer, käesoleva faasi 
number 
 
Kontrollvahemik graafilises formaadis (uueneb iga 10 sekundi möödumisel, 
ekraanil on viimase 8 minuti andmed) 
 
Südame löögisagedus 
 
Faasi kordumiste arv 
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Iga faasi lõppemisel kuvatakse ekraanile: 
 
Faasi ajaline kestus või vahemaa* 
 
Südame löögisageduse erinevus (kui palju südame löögisagedus suurenes 
või vähenes faasi jooksul) või keskmine kiirus/tempo 
 
Keskmine südame löögisagedus 
 
Lõppenud faasi number 

 

Programmi kuuluva treeningu lõpetamisel kuvatakse ekraanile teade 
lõpetamise kohta. 
 
Jooksukompuuter läheb üle treeningu Free režiimi ja teil on võimalik jätkata 
treeningut ilma seadistusi kasutamata. Treeningu andmete salvestamine 
jätkub ja kogutakse menüüsse File, kuni te treeningu lõpetate. 

 
Lisainfot selle kohta, kuidas plaanida treeninguid tarkvara abil ning seejärel neid jooksukompuutrisse 
üle kanda leiate tarkvara abifailist. 
 
Funktsioonid treeningu ajal 
 
Teil on võimalik programmi kuuluva treeningu puhul muuta seadistusi samamoodi nagu iga teise 
treeningu puhul. Lisainfot erinevate funktsioonide kohta treeningu ajal leiate lõigust Nuppude 
funktsioonid treeningu ajal. 
 
Programmi kuuluv treening kasutab tarkvara abil seatud spordiprofiili seadistusi. Kui te muudate 
jooksukompuutri seadistusi treeningu ajal (näiteks kalibreerimisfaktorit), siis mõjuvad need muutused 
ainult toimuva treeningu ajal. Järgmisel korral, kui kasutate sama treeningut, võtab jooksukompuuter 
kasutusele need seadistused, mis tulenevad tarkvara abil seatud spordiprofiilist. 
 
Ringiaegade menüü 
 
Selleks, et kuvada ekraanile ringiaegade menüü programmi kuuluva treeningu puhul, vajutage ja 
hoidke all nuppu OK. Liikuge võimaluste vahel nuppude UP ja DOWN abil ja tehke oma valik 
vajutades nuppu OK. Ringiaegade menüü sisu sõltub teie treeningust. 
 
• End phase: Käesoleva faasi lõpetamine ja treeningu järgmise faasi juurde liikumine. 
• Jump to: Treeningu muu faasi juurde liikumine. 
• Lock zone või Unlock zone: Lukustage südame löögisagedus või kiirus/tempo* kindlasse 

sporditsooni, kui kasutate ilma seadistusteta treeningut. 
 
Treeningu tulemuste vaatamine. 
Valige File > Exercise Log. 
 
Kui olete läbi teinud programmi kuuluva treeningu, salvestatakse treeningu tulemused menüüsse File. 
Lisainfot leiate lõigust Treeningu tulemuste analüüsimine. 
 
* Vajalik on lisavarustusena saadaolev jooksu kiiruseandur S1. 
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9. TESTID 
 
Polar Fitness Test™ 

 
Polar Fitness Test™ on lihtne, ohutu ja kiire meetod oma aeroobse (kardiovaskulaarse) võimekuse 
kindlakstegemiseks rahuolekus. Testi tulemus, Polar OwnIndex, on väärtus, mis on võrreldav 
maksimaalse hapnikutarbimise (VOmax) näiduga, mida sageli kasutatakse aeroobset võimekust 
kirjeldava näitajana. Teie pikaajaline kehalise aktiivsuse tase, südame löögisagedus, südame 
löögisageduse vahelduvus rahuolekus, sugu, vanus, pikkus ja kehakaal mõjutavad OwnIndexit. Polar 
Fitness Test on mõeldud tervetele täiskasvanutele. 
 
Aeroobne võimekus on seotud sellega, kui hästi saab kardiovaskulaarne süsteem hakkama hapniku 
transpordiga organismis. Mida parem on aeroobne võimekus, seda tugevam on süda ja efektiivsem 
selle töö. Heal aeroobsel võimekusel on mitmeid eeliseid, näiteks vähendab see südame ja 
veresoonkonnahaigustesse ja kõrgvererõhutõppe haigestumise ning insuldi riski. Kui te soovite 
parandada oma aeroobset võimekust, on märgatava muutuse saavutamiseks vajalik regulaarne 
treenimine vähemalt 6 nädala vältel. Halvemas vormis isikutel on tulemused näha isegi kiiremini. 
Mida parem on aeroobne võimekus, seda väiksemad on muudatused OwnIndexi väärtuses. 
 
Aeroobne võimekus paraneb kõige tõhusamalt spordialade puhul, mille juures kasutatakse suuri 
lihasgruppe. Nendeks on näiteks jooksmine, jalgrattasõit, kõndimine, sõudmine, ujumine, uisutamine 
ja murdmaasuusatamine. 
 
Et oleks võimalik jälgida võimekuse paranemist, tuleb usaldusväärse algväärtuse saamiseks esimese 
kahe treeningunädala jooksul OwnIndexit määrata mitu korda. Seejärel tuleks testi korrata umbes üks 
kord kuus. 
 
Polar Fitness Test arvutab välja ka eeldatava maksimaalse südame löögisageduse (HRmax-p). HRmax-
p väärtus ennustab teie individuaalset maksimaalset südame löögisageduse väärtust täpsemini kui 
vanusel põhinev valem 220-vanus. Lisainfot HRmax-p kohta leiate lõigust Kasutajaandmed. 
 
Selleks, et tagada testi tulemuse usaldusväärsus, tuleb pidada kinni järgmistest põhitingimustest: 
• Test võib toimuda ükskõik kus – kodus, tööl või spordiklubis – tingimusel, et ümbritsev keskkond 

on rahulik. Ümberringi ei tohiks olla häirivaid helisid (näiteks töötavat telerit, raadiot ega 
helisevaid telefone), ega teisi inimesi, kes teid häirida võiks. 

• Korrake testi samas kohas, samal kellaajal ning samades tingimustes. 
• Hoiduge 2-3 tundi enne testi rohkest söömisest ja suitsetamisest. 
• Hoiduge raskest kehalisest pingutusest, alkohoolsetest jookidest ja stimuleerivatest ainetest testi 

läbiviimise ja sellele eelneval päeval. 
• Peate olema lõdvestunud ja rahulik. Heitke pikali ja lõdvestuge 1-3 minuti jooksul enne testi. 
 
Enne testi 
 
Pange peale vööandur. 
Lisainfot leiate lõigust Treeningu alustamine. 
 
Sisestage kasutajaandmed. 
Valige Settings > User. 
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Polar Fitness Testi läbiviimiseks peate te sisestama oma kasutajaandmed ja pikaajalise kehalise 
aktiivsuse taseme. Lisainfo leiate lõigust Kasutajaandmed. 
 
Lülitage sisse funktsioon HRmax-p. 
Valige Test > Fitness > HRmax-p > On. 
 
Testi läbiviimine 
 
Valige Test > Fitness > Start > Fitness Test Lie Down. 
 
Test algab viie sekundi jooksul. Ekraanile ilmuvad nooled viitavad testi toimumisele. Püsige 
lõdvestununa ja hoidke tagasi kehaliigutusi ja soovi teiste inimestega suhelda. 
 
Kui te ei ole sisestanud oma pikaajalise kehalise aktiivsuse taset kasutajaandmete seadistuste 
juures, ilmub ekraanile Set your personal activity level. Valige Top, High, Moderate või Low. 
Lisainfo kehalise aktiivsuse tasemete kohta leiate lõigus Kasutajaandmed. 
 
Kui jooksukompuuter ei suuda registreerida südame löögisageduse signaali testi alguses või selle 
kestel, test ebaõnnestub ja ekraanile ilmub Test failed, check WearLink. Veenduge, et vööanduri 
elektroodid on niisutatud ning elektroodid on tihedalt vastu keha ja käivitage test uuesti. 
 
Kui test lõppeb, kostub kaks helisignaali. Ekraanile ilmub OwnIndex numbrilise väärtusena ja 
sõnalise hinnanguna. Lisainfo hinnangute kohta leiate lõigus Kehalise võimekuse klassid. 
 
Oma eeldatava maksimaalse südame löögisageduse väärtuse nägemiseks vajutage nuppu DOWN. 
Vajutage väljumiseks nuppu OK. 
 
Update VO2 max? 
• Valige Yes OwnIndexi tulemuse salvestamiseks kasutajaandmetesse ja Fitness Test Trend 

menüüsse. 
• Valige No vaid siis, kui teate oma laboratoorselt mõõdetud VO2max väärtust ja see erineb enam 

kui ühe kehalise võimekuse klassi võrra OwnIndexist. Sellisel juhul salvestatakse tulemus vaid 
Fitness Test Trend menüüsse. Lisainfo leiate lõigust Fitness Test Trend. 

 
Update HR max? (kui funktsioon HRmax-p oli sisse lülitatud) 
• Valige Yes tulemuse salvestamiseks kasutajaandmetesse. 
• Valige No, kui te teate oma laboratoorselt mõõdetud maksimaalset südame löögisagedust. 
 
Teil on võimalik test igal hetkel katkestada vajutades nuppu STOP. Ekraanile ilmub mõneks 
sekundiks Fitness Test canceled. 
 

 
OwnIndexi ja HRmax-p väärtuste salvestamisel võetakse need aluseks kalorikulu 
arvestamisel. 

 
Testi järel 
 
Kehalise võimekuse klassid 
 
Testi tulemus – OwnIndex – on kõige tähendusrikkam, kui seda võrrelda oma individuaalsete 
väärtustega ja jälgida selle muutusi. OwnIndexit saab tõlgendada ka soost ja vanusest lähtuvalt. 
Leidke järgnevast tabelist oma OwnIndexi asukoht teie vanusele vastavas reas, et kindlaks teha oma 
võimekuse tase ja võrrelge seda nendega, kes on samast soost ja vanuses. 
 
Vastupidavusalade tippsportlastel ületab OwnIndexi väärtus meestel 70 ja naistel 60. 
Olümpiatasemel sportlased saavutavad OwnIndexi väärtuseks umbes 95. OwnIndexi väärtus on 
kõige suurem nende alade sportlastel, kelle treeningud hõlmavad suurte lihasgruppide tööd, näiteks 
murdmaasuusatamine ja jalgrattasport. 
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 Vanus 

(aastad) 
1 
(väga 
nõrk) 

2 
(nõrk) 

3 
(rahuldav) 

4 
(keskmine) 

5 
(hea) 

6 
(väga 
hea) 

7 
(suure-
pärane) 

20-24 ≤ 32 32-37 38-43 44-50 51-56 57-62 >62 
25-29 ≤ 31 31-35 36-42 43-48 49-53 54-59 >59 
30-34 ≤ 29 29-34 35-40 41-45 46-51 52-56 >56 
35-39 ≤ 28 28-32 33-38 39-43 44-48 49-54 >54 
40-44 ≤ 26 26-31 32-35 36-41 42-46 47-51 >51 
45-49 ≤ 25 25-29 30-34 35-39 40-43 44-48 >48 
50-54 ≤ 24 24-27 28-32 33-36 37-41 42-46 >46 
55-59 ≤ 22 22-26 27-30 31-34 35-39 40-43 >43 

MEHED 

60-65 ≤ 21 21-24 25-28 29-32 33-36 37-40 >40 
 
 Vanus 

(aastad) 
1 
(väga 
nõrk) 

2 
(nõrk) 

3 
(rahuldav) 

4 
(keskmine) 

5 
(hea) 

6 
(väga 
hea) 

7 
(suure-
pärane) 

20-24 ≤ 27 27-31 32-36 37-41 42-46 47-51 >51 
25-29 ≤ 26 26-30 31-35 36-40 41-44 45-49 >49 
30-34 ≤ 25 25-29 30-33 34-37 38-42 43-46 >46 
35-39 ≤ 24 24-27 28-31 32-35 36-40 41-44 >44 
40-44 ≤ 22 22-25 26-29 30-33 34-37 38-41 >41 
45-49 ≤ 21 21-23 24-27 28-31 32-35 36-38 >38 
50-54 ≤ 19 19-22 23-25 26-29 30-32 33-36 >36 
55-59 ≤ 18 18-20 21-23 24-27 28-30 31-33 >33 

NAISED 

60-65 ≤ 16 16-18 19-21 22-24 25-27 28-30 >30 
See klassifikatsioon põhineb 62 uurimuse põhjal koostatud ülevaatel. Uurimustes mõõdeti USAs, 
Kanadas ja 7 Euroopa riigis tervetel täiskasvanutel VOmax. Allikas: Shvartz E, Reihold RC: Aerobic 
fitness norms for males and females aged 6 to 75 years: a review. Aviat Space Environ Med; 61:3-11, 
1990. 
 
Fitness Test Trend 
 
Valige Test > Fitness > Trend. 
 
Menüüs Trend saate te jälgida OwnIndexi muutusi ajas. Võimalik on jälgida kuni 16 OwnIndexi 
väärtust koos testi sooritamise kuupäevaga. Kui tulemuste mälu saab täis, asendab hiliseim tulemus 
varaseima tulemuse. 
 
Ekraanile ilmub viimase testi kuupäev, OwnIndexi väärtuste graafik ja viimane OwnIndexi väärtus. 
Tulemuste vahel saate liikuda nuppude UP ja DOWN abil.  
 
OwnIndexi väärtuse kustutamine 
 
Valige Test > Fitness > Trend. 
 
Valige väärtus, mida te soovite kustutada ja vajutage ja hoidke all nuppu LIGHT > Delete value? 
Ekraanile ilmub No/Yes. Valiku kinnitamiseks vajutage nuppu OK. 
 
OwnIndexi väärtuste analüüs tarkvara abil. 
 
Andmete ülekanne tarkvarasse võimaldab teil tulemusi analüüsida mitmel erineval viisil, samuti saate 
teada rohkem informatsiooni oma edusammude kohta. Tarkvara abil saate te teha ka graafilisi 
võrdlusi eelnevate tulemustega. 
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Polar OwnOptimizer™ 

 
Üldinfo 
 
Edukas treening eeldab organismi ajutist ülekoormamist: selle saavutamiseks võib kasutada pikemat 
treeningu kestust, kõrgemat intensiivsust või suuremat treeningu kogumahtu. Selleks, et ära hoida 
tugevat ületreeningut, peab ülekoormusele järgnema adekvaatne taastumisperiood. Ebapiisava 
taastumise korral võib ülekoormus esile kutsuda kehalise võimekuse languse selle juurdekasvu 
asemel. Polar OwnOptimizer funktsioon pakub teile lihtsat ja usaldusväärset võimalust teada saada, 
kas teie treeningprogrammi käigus teie võimekus suureneb optimaalselt. Polar OwnOptimizer on 
mõeldud tervetele täiskasvanutele. 
 
Polar OwnOptimizer on traditsioonilise ortostaatilise ületreeningu testi modifikatsioon. See on täiuslik 
jooksukompuutrisse integreeritud abivahend kehalise võimekuse parandamise või võistlustulemuse 
parandamise eesmärgil treenivatele inimestele, kes treenivad regulaarselt vähemalt kolm korda 
nädalas. See funktsioon põhineb südame löögisageduse ja südame löögisageduse vahelduvuse 
mõõtmisel ortostaatilise testi (organismi üleminek puhkeasendist püstiasendisse) käigus. 
OwnOptimizer aitab teil reguleerida treeningkoormust teie treeningprogrammi ajal, nii et teie kehaline 
võimekus suureneks ning pikas perspektiivis ei tekiks üle- ega alatreeningut. Polar OwnOptimizer 
põhineb 5 südame löögisageduse parameetri pikaajalisel regulaarsel jälgimisel. Kaks viiest 
parameetrist mõõdetakse rahuolekus, üks ülestõusmisel ning kaks püstiseismisel. Iga kord, kui te 
testi teete, salvestab randmevastuvõtja südame löögisageduse andmed ja võrdleb neid eelnevalt 
salvestatud andmetega. 
 
Enne testi 
 
Baasandmete kogumine 
 
Kui hakkate OwnOptimizer funktsiooni kasutama esimest korda, tuleb kõigepealt kahe nädala jooksul 
sooritada kuus testi teie isiklike baasandmete kogumiseks. Need mõõtmised tuleks teha kahe tavalise 
treeningnädala jooksul, mitte raskete treeningute perioodi jooksul. Baasandmete kogumise mõõtmiste 
seas peaks olema ka treeningute järel ja ka puhkepäevadel tehtud mõõtmisi. 
 
OwnOptimizer väärtuste jälgimine 
 
Kui olete sooritanud baasandmete kogumiseks vajalikud mõõtmised, peaksite te jätkama testi 
tegemist 2-3 korda nädalas. Testige end igal nädalal hommikuti pärast taastumisele pühendatud 
päeva ja raske treeningu päeva (või raskete treeningpäevade seeria järel). Võite teha ka kolmanda 
testi tavalise treeningpäeva järel. OwnOptimizer väärtus ei pruugi olla usaldusväärne madala 
treenituse perioodil või ebakorrapäraste treeningute korral. Kui peatate treeningud enam kui 14 
päevaks, peate te uuesti koguma baasandmed. 
 
Testi läbiviimine 
 
Usaldusväärsete tulemuste saamiseks tuleb test alati läbi viia standardtingimustes või võimalikult 
ühesugustes tingimustes. Test on soovitav teha hommikul enne hommikusöögi söömist. Selleks, et 
saada usaldusväärseid tulemusi, tuleks lähtuda järgnevatest põhitingimustest: 
• Pange peale vööandur. Lisainfo leiate lõigus Treeningu alustamine. 
• Te peate olema lõdvestunud ja rahulik. 
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• Te võite rahuolekus olla kas istukil või lamades. Te peate alati alustama testi samast asendist. 
• Testi võib läbi viia kus iganes – kodus, kontoris, terviseklubis – tingimusel, et ümbritsev 

keskkond on rahulik. Ümberringi ei tohiks olla segavaid helisid (näiteks telerit, raadiot või 
telefoni) ega teisi inimesi, kes võiksid teid segada. 

• Hoiduge söömisest, joomisest ja suitsetamisest vähemalt 2-3 tundi enne testi sooritamist. 
 
Testi läbiviimine 
 
Valige Test > Optimizer > Start > Optimizer Lie Down. 
 
Ekraanile ilmuvad nooled viitavad testi toimumisele. Ärge liigutage testi esimese osa ajal, mis kestab 
3 minutit. 
 
Kolme minuti möödudes kostub helisignaal ja ekraanile ilmub Optimizer Stand up. Tõuske üles ja 
jääge liikumatult seisma kolmeks minutiks. 
 
Kolme minuti möödudes kostub helisignaal ja test on lõppenud. 
 
Ekraanile ilmub tulemuse numbriline ja sõnaline hinnang. Vajutage nuppu DOWN, et näha keskmist 
südame löögisagedust löökidena minutis puhkeasendis (HRrest), kõrgemat südame löögisagedust 
püstitõusmisel (HRpeak) ja keskmist südame löögisagedust püstiasendis (HRstand). 
 
Teil on võimalik test igal hetkel katkestada vajutades nuppu STOP. Ekraanile ilmub mõneks 
sekundiks Optimizer Test canceled. 
 
Kui jooksukompuuter ei suuda registreerida südame löögisageduse signaali testi alguses või selle 
kestel, test ebaõnnestub ja ekraanile ilmub Test failed, check WearLink. Veenduge, et vööanduri 
elektroodid on niisutatud ning elektroodid on tihedalt vastu keha ja käivitage test uuesti. 
 
Testi järel 
 
Testi tulemuste tõlgendamine 
 
Jooksukompuuter võtab arvesse viit südame löögisageduse ja südame löögisageduse vahelduvuse 
parameetrit. Hinnang OwnOptimizer testi tulemusele antakse viimase testi tulemuse võrdlemisel 
eelmiste testide tulemustega. Randmevastuvõtja ekraanile kuvatakse sõnaline hinnang teie staatuse 
kohta. Nende selgitused leiate allpool. 
 
Good Recovery / Hea taastumine (1) 
Teie testi ajal mõõdetud südame löögisageduse väärtused on keskmisest madalamad. See viitab 
sellele, et te olete väga hästi treeningutest taastunud. Te võite jätkata treeninguid, sealhulgas 
intensiivseid treeninguid. 
 
Normal State / Normaalne treeningseisund (2) 
Teie testi ajal mõõdetud südame löögisageduse väärtused on normaalsel tasemel. Jätkake 
treeninguid, kasutage kergemaid ja intensiivsemaid treeninguid ning tehke puhkepäevi. 
 
Training Effect / Treeniv efekt (3) 
Teie testi ajal mõõdetud südame löögisageduse väärtused on keskmisest kõrgemad. Tõenäoliselt 
olete eelmistel päevadel teinud intensiivseid treeninguid. Teil on kaks valikut: 1) puhake või treenige 
kergema koormusega järgnevate päevade jooksul, või 2) jätkake intensiivseid treeninguid ühe või 
kahe päeva jooksul ning seejärel taastuge korralikult. Ka teised stressi allikad, palavikulise 
külmetushaiguse algus või grippi haigestumine võivad esile kutsuda sellise tulemuse. 
 
Steady State / Püsiv treenituse seisund (4) 
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Teie testi ajal mõõdetud südame löögisageduse väärtused on olnud püsivalt normaalse taseme 
läheduses pika perioodi jooksul. Efektiivne treening eeldab nii raskeid treeninguid kui ka head 
taastumist, mis peaks esile kutsuma südame löögisageduse muutumise. OwnOptimizer testi tulemus 
viitab sellele, et teil pole viimasel ajal olnud intensiivseid treeninguid või piisavat taastumist 
treeningutest. Korrake testi puhkepäeva järel või kerge treeninguga päeva järel. Kui taastumine on 
efektiivne, peaks teie uue testi tulemus olema Good Recovery. 
 
Stagnant State / Muutusteta treeningu seisund (5) 
Teie testi ajal mõõdetud südame löögisageduse väärtused on ikka veel normaalsel tasemel, ning 
seda juba pika aja jooksul. Testi tulemus viitab sellele, et teie treeningud pole olnud piisavalt 
intensiivsed, et optimaalselt areneda. Selleks, et arendada oma kehalist võimekust, peaksid 
treeningud sisaldama ka intensiivsemaid osi või treeningud peaksid olema pikemad. 
 
Hard Training / Tugev treeningefekt (6) 
Teie testi ajal mõõdetud südame löögisageduse väärtused on olnud normaalsest kõrgemal juba mitu 
korda. Tõenäoliselt olete te sihilikult treeninud suurema koormusega. Testi tulemus viitab 
ülekoormusele ning teil tuleks korralikult taastuda. Taastumise kontrolliks korrake testi ühe või kahe 
puhkepäeva või kerge koormusega treeningpäeva järel. 
 
Overreaching / Ülepingutamine (7) 
Teie OwnOptimizer testi tulemus viitab sellele, et teil on mitme päeva või nädala jooksul olnud väga 
intensiivse treeningu periood. Teie testi ajal mõõdetud südame löögisageduse väärtused on olnud 
kõrged. See viitab sellele, et vajate täielikku taastumist. Mida kauem olete intensiivselt treeninud, 
seda pikemat perioodi vajate taastumiseks. Korrake testi kahe puhkepäeva järel. 
 
Sympathetic Overtraining / Sümpaatiline ületreening (8) 
Teie OwnOptimizer testi tulemus viitab sellele, et teil on mitme päeva või nädala jooksul olnud väga 
intensiivse treeningu periood ning teie taastumine on olnud ebapiisav. Te olete hetkel ületreeningu 
seisundis. Normaalse treeningseisundi saavutamiseks peate te taastuma kontrollitud 
taastumisperioodi jooksul. Kontrollige oma taastumist OwnOptimizer testi abil 2-3 korda nädalas. 
 
Parasympathetic Overtraining / Parasümpaatiline ületreening (9) 
Teie testi ajal mõõdetud südame löögisageduse väärtused on madalal tasemel, mis reeglina viitab 
heale taastumisele. Sellegipoolest, teised parameetrid viitavad parasümpaatilisele ületreeningule. 
Tõenäoliselt olete treeninud pikema aja jooksul suure koormusega ning te pole jätnud piisavalt aega 
taastumiseks. Kontrollige, kas teil on avaldunud muud ületreeningule viitavad sümptomid. Näiteks 
viitavad ületreeningule vähenenud kehaline võimekus, suurenenud väsimus, tujutus, unehäired, püsiv 
lihaste kangus ja/või läbipõlemise tunne või tülpimus. Sellise tulemuseni võivad viia ka muud 
stressiseisundid. 
 
Tavaliselt eeldab parasümpaatilise ületreeningu tekkimine pikaajalist suure mahuga treenimist. 
Selleks, et taastuda parasümpaatilise ületreeningu seisundist, tuleb täielikult taastada kehaline 
tasakaal. Taastumine võib võtta mitu nädalat. Te ei tohiks treenida, pigem peaksite puhkama kogu 
taastumisperioodi jooksul. On lubatav, et teete mõned aeroobsed treeningud ja vaid mõned lühikesed 
kõrge intensiivsusega lõigud. 
 
Samuti võikside kaaluda sel ajal mõne muu spordiala kui teie põhiala treenimist. Sellegipoolest peaks 
see olema selline spordiala, mida te tunnete ja mis on teile meeldiv. Kontrollige oma taastumist 
OwnOptimizer testi abil 2-3 korda nädalas. Kui te tunnete, et olete taastunud ning OwnOptimizer testi 
tulemuseks on Normal State või Good recovery, eelistatavalt enam kui üks kord, võite kaaluda taas 
tavalise treeningprogrammi juurde naasmist. Kui olete uueks treeningperioodiks valmis, peaksite 
alustama uut testimisperioodi ning peaksite koguma uuesti baasandmed. 
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Enne kui muudate põhimõtteliselt oma treeningprogrammi, kaaluge koos nii OwnOptimizer 
testi tulemust kui ka oma subjektiivset enesetunnet ja sümptomeid. Kui te pole kindel, kas 
test toimus standardtingimustel, korrake testi. Üksikut testi tulemust võivad mõjutada mitu 
välist faktorit, näiteks vaimne stress, peidetud haigus, muutused keskkonnas (temperatuur, 
kõrgus) jms. OwnOptimizer testi baasandmeid tuleb uuendada vähemalt üks kord aastas, 
tavaliselt uue treeningaasta alguses. 

 
OwnOptimizer Trend 
 
Valige Test > Optimizer > Trend. 
 
Menüüs Trend näete, kuidas on muutunud OwnOptimizer väärtus. Võimalik on jälgida kuni 16 
OwnOptimizeri väärtust koos testi sooritamise kuupäevaga. Kui tulemuste mälu saab täis, asendab 
hiliseim tulemus varaseima tulemuse. 
 
Ekraanile ilmub viimase testi kuupäev, OwnOptimizer väärtuste graafik ja viimane OwnIndexi väärtus. 
Vajutades nuppu OK näete tulemuse sõnalist hinnangut. Tulemuste vahel saate liikuda nuppude UP 
ja DOWN abil.  
 
OwnOptimizer väärtuse kustutamine 
 
Valige Test > Optimizer > Trend. 
 
Valige väärtus, mida te soovite kustutada ning vajutage ja hoidke all nuppu LIGHT > Delete value? 
Ekraanile ilmub No/Yes. Valiku kinnitamiseks vajutage nuppu OK. 
 
Trendi faili nullimine 
Valige Test > Optimizer > Reset. 
Teil on võimalik OwnOptimizer testide periood nullida. Kõik testi tulemused kustutatakse mälust. Kui 
testimisperiood ületab 365 päeva või pole te testinud viimase 30 päeva jooksul, ilmub ekraanile 
Reset test period? (Kas nullida testide periood?). 
 
OwnOptimizer väärtuste analüüs tarkvara abil. 
 
Andmete ülekanne tarkvarasse võimaldab teil tulemusi analüüsida mitmel erineval viisil, samuti saate 
teada rohkem informatsiooni oma edusammude kohta. Tarkvara abil saate te teha ka graafilisi 
võrdlusi eelnevate tulemustega. 
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10. TAUSTAINFORMATSIOON 
 
Polari sporditsoonid 
 
Polari sporditsoonide abil on võimalik saavutada südame löögisagedusel põhinevate treeningute uus 
efektiivsuse tase. Treeningud jaotatakse viide tsooni, mis põhinevad protsendil maksimaalsest 
südame löögisagedusest. Sporditsoonide abil on teil lihtne valida ja jälgida treeningute intensiivsust. 
 
Tsoon Intensiivsus 

% SLSmax-st 
Kestuse näide Treeningu mõju 

MAXIMUM 

 

90–100% 
171–190 
lööki minutis 

alla 5 minuti Tulemus: Maksimaalne või selle lähedane 
pingutus lihaste ja hingamise jaoks 
Tunne: Väga pingeline 
hingamiselundkonna ja lihaste jaoks 
Soovitus: Väga kogenud ja kõrge kehalise 
võimekusega sportlastele. Vaid lühikesed 
intervallid, tavaliselt lõplikul 
ettevalmistusel lühikesteks 
jooksudistantsideks 

HARD 

 

80–90% 
152–171 
lööki minutis 

2–10 minutit Tulemus: Paranenud võime hoida 
kiiruslikku vastupidavust 
Tunne: Väsimus lihastes ja raske 
hingeldamine 
Soovitus: Kogenud jooksjatele 
treeninguteks kogu aasta jooksul erineva 
pikkusega lõikudel. Muutub oluliseks 
võistluseelsel perioodil. 

MODERATE 

 

70–80% 
133–152 
lööki minutis 

10–40 minutit Tulemus: Parandab üldist 
treeningutempot, muudab mõõduka 
koormusega treeningud kergemaks ja 
parandab efektiivsust. 
Tunne: Ühtlane kontrollitud kiire 
hingamine 
Soovitus: Võistlusteks ettevalmistuvatele 
või võimekust parandavatele jooksjatele , 
eriti pool- ja täismaratonideks 
ettevalmistujatele. 

LIGHT 

 

60–70% 
114–133 
lööki minutis 

40–80 minutit Tulemus: Põhivastupidavuse 
parandamine ja taastumise edendamine, 
ainevahetuse parandamine 
Tunne: Mõnus ja kerge, madal koormus 
lihastele ja südame-vereringesüsteemile 
Soovitus: Igaühele pikkadeks 
treeninguteks ettevalmistusperioodil või 
taastumiseks võistlusperioodil 

VERY LIGHT 

 

50–60% 
104–114 
lööki minutis 

20–40 minutit Tulemus: Aitab soojendusel ja 
lõdvestusel, aitab taastuda 
Tunne: Tundub väga kergena, väike 
pingutus 
Soovitus: Taastumiseks ja lõdvestumiseks 
kogu hooaja jooksul 

SLSmax = maksimaalne südame löögisagedus (220-vanus). Näites: 30-aastane inimene, 220-30=190. 
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Treening (jooksmine) sporditsoonis 1 toimub väga madala intensiivsusega. Treeningu põhimõte 
seisneb võimekuse taseme tõusus treeningujärgse taastumise käigus, mitte ainult treeningu enda 
ajal. Te saate taastumist kiirendada väga madala intensiivsusega treeningu abil. 
 
Vastupidavustreening toimub sporditsoonis 2, mis on iga treeningu oluline osa. Jooksmine selles 
sporditsoonis on kergeks aeroobseks treeninguks. Pika kestusega treening selles madala 
intensiivsusega tsoonis on efektiivne ka energia kulutamise seisukohast. Vastupidavustreeningu 
edusammud eeldavad püsivust. 
 
Aeroobset võimekust on võimalik arendada sporditsoonis 3. Treeningu intensiivsus selles tsoonis 
on kõrgem kui sporditsoonides 1 ja 2, kuid koormus on ikka veel aeroobne. Treening sporditsoonis 3 
võib koosneda näiteks intervallidest, millele järgneb taastumine. Jooksmine selles tsoonis on eriti 
efektiivne südame ja skeletilihaste vereringe tõhususe parandamiseks. 
 
Kui teie eesmärgiks on võistlemine oma potentsiaalse tipu lähedal, peate te kasutama ka tsoone 4 ja 
5. Nendes tsoonides treenite anaeroobselt, kuni 10-minutiliste intervallidena. Mida lühem on 
pingutusintervall, seda kõrgem peab olema intensiivsus. Väga tähtis on piisav taastumine intervallide 
vahel. Treening tsoonides 4 ja 5 on mõeldud sportlase tippvormi lähedale jõudmiseks. 
 
Polari sporditsoone saab seada täpsemaks teades oma laboris mõõdetud maksimaalset südame 
löögisagedust või tehes maksimaalse pingutuse testi iseseisvalt. Kui treenite ühes sporditsoonis, on 
treeningu eesmärgiks kogu vahemiku kasutamine. Tsooni keskel püsimine on lihtne eesmärk, kuid ei 
ole tarvis hoida oma südame löögisagedust ühel tasemel kogu aeg. Südame löögisagedus kohaneb 
treeningu intensiivsusega aeglaselt (viivitusega). Näiteks kui liigute tsoonist 1 tsooni 3 võib 
vereringesüsteemi kohanemine aega võtta 3 kuni 5 minutit. 
 
Südame löögisageduse reaktsioon kindla intensiivsusega treeningule sõltub treeningust, 
taastumisest, keskkonnast ja teistest mõjuritest. Seetõttu tuleks pöörata tähelepanu tekkivale 
väsimustundele ja muuta vastavalt ka treeningprogrammi. 
 
Lihtne viis sporditsoonide kasutamiseks on nende kasutamine kontrollvahemikena. Lisainfo leiate 
lõigust Treeningute plaanimine. 
 
Treeningu järel näete treeningu kestuse jaotust sporditsoonidesse. Vaadake menüüs Weekly järgi, 
millistes sporditsoonides treenisite ja kui palju aega veetsite kindlas sporditsoonis. 
 
Polar ProTrainer 5 tarkvara pakub kuni 10 sporditsooni kasutamise võimalust oma 
treeninguvajaduste rahuldamiseks ja südame löögisageduse reservi ärakasutamiseks. 
 
OwnZone-treeningud 
 
Jooksukompuuter leiab automaatselt individuaalse aeroobseks treeninguks sobiva treeningvahemiku: 
OwnZone’i. Unikaalne Ownzone funktsioon määrab kindlaks treeningtsooni aeroobseteks 
treeninguteks. See funktsioon juhendab teid treeningu ajal ja võtab arvesse teie hetke kehalist ja 
vaimset seisundit. Enamuse täiskasvanute puhul vastavad OwnZone piirid vahemikule 65-85% 
maksimaalsest südame löögisagedusest. 
 
OwnZone’i kontrollvahemiku piirid on võimalik leida 1-5-minutilise soojenduse ajal, kusjuures 
soojenduseks sobib näiteks käimine, sörkjooks või mõne muu spordiala harrastamine. Tähtis on 
alustada treeningut aeglaselt ja madala intensiivsusega ning seejärel tõsta sujuvalt koormuse kaudu 
südame löögisagedust. OwnZone on mõeldud kasutamiseks tervetel inimestel. Teie tervislik seisund, 
näiteks kõrge vererõhk, südamearütmia ning teatud medikamentide võtmine, võib põhjustada 
südame löögisagedusel põhineva OwnZone’i leidmise ebaõnnestumise. 
 
Kehalise võimekuse parandamise oluline osa on keha poolt treeningu ajal saadetavate signaalide 
kuulamine ja tõlgendamine. OwnZone funktsiooni kasutamine iga treeningu eel garanteerib kõige 
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efektiivsema kontrollvahemiku leidmise eelseisvaks treeninguks konkreetsel päeval, sest 
soojendusharjutused erinevad üksteisest erinevate treeningute puhul ning kehaline ja vaimne seisund 
võib samuti olla erinev erinevatel päevadel (näiteks stressi või haiguse tõttu). 
 
Maksimaalne südame löögisagedus 
 
Maksimaalne südame löögisagedus (SLSmax) on maksimaalse kehalise pingutuse korral saavutatav 
suurim südamelöökide arv minutis. See on individuaalne ja sõltub vanusest, pärilikest faktoritest ja 
kehalise võimekuse tasemest. See võib sõltuda ka sellest, millise spordiala harrastamisel seda 
mõõdetakse. Maksimaalset südame löögisagedust kasutatakse treeningute intensiivsuse 
väljendamiseks. 
 
Maksimaalse südame löögisageduse kindlakstegemine 
 
Maksimaalset südame löögisagedust (SLSmax) on võimalik kindlaks teha mitmel moel. 
• Kõige täpsem on SLSmax kliiniline mõõtmine, tavaliselt toimub see kardioloogi või sporditeadlase 

järelvalve all maksimaalse pingutuse testi käigus jooksurajal või veloergomeetril. 
• Teil on võimalik SLSmax kindlaks teha iseseisvalt näiteks koos treeningpartneriga treenides. 
• Teil on võimalik teada saada eeldatav maksimaalne südame löögisagedus (HRmax-p) Polar 

Fitness Testi käigus. 
• SLSmax on võimalik välja arvutada valemi 220-vanus abil, kuid teaduslikud uuringud näitavad, et 

see meetod ei ole usaldusväärne, eriti vanemate inimeste puhul, kes on olnud pikka aega heas 
vormis. 

 
Kui te olete teinud viimaste nädalate jooksul raskemaid treeninguid ja teate, et suudate maksimaalse 
südame löögisageduse saavutada ohutult, võite maksimaalse pingutuse testi sooritada iseseisvalt. 
Soovitav on treeningkaaslase juuresolek. Kui kahtlete, konsulteerige enne testimist oma arstiga. 
 
Siin on lihtsa testi näide. 
1. aste: Tehke tasasel maastikul 15-minutiline soojendus, viies tempo oma tavalise treeningutempo 
tasemele. 
2. aste: Valige välja küngas või trepp, mille tippu jõudmiseks teil kulub enam kui 2 minutit. Jookske 
künkast/trepist üles, tõstes tempo selliseks, mida te oleksite suutelised hoidma 20 minuti jooksul. 
Laskuge künka jalamile / trepist alla tagasi. 
3. aste: Jookske veelkord künkast/trepist üles tempos, mida te suudaksite hoida 3 km läbimisel. 
Märkige üles kõrgeim südame löögisageduse näit. Teie maksimaalne südame löögisagedus on 
ligikaudu 10 lööki kõrgem ülesmärgitud väärtusest. 
4. aste: Jookske künkast/trepist alla, et teie südame löögisagedus langeks 30-40 löögi võrra minutis. 
5. aste: Jookske künkast/trepist üles tempos, mida suudate hoida 1 minuti jooksul. Proovige joosta 
poole vahemaast tipuni. Märkige üles kõrgeim südame löögisageduse näit. See peaks olema teie 
maksimaalse südame löögisageduse lähedal. Kasutage seda näitu maksimaalse südame 
löögisageduse näiduna treeningtsoonide seadmisel. 
6. aste: Kindlasti tehke vähemalt 10-minutiline lõdvestus. 
 
Südame löögisagedus isteasendis 
 
HRsit on teie keskmine südame löögisagedus täielikus puhkeolekus (näiteks istudes). Selleks, et 
mõõta HRsit väärtus, võtke istet, pange peale vööandur ja ärge tegelge kehalise koormusega. HRsit 
väärtuse täpseks teadasaamiseks korrake mõõtmisi mitu korda ning arvutage välja mõõtmiste 
keskmine. 
 
Polar Running Index 
 
Running Index võimaldab kiiresti jälile saada võimekuse muutustele. Võimekust (kui kiiresti/kergelt 
suudate kindla tempoga joosta) mõjutab otseselt aeroobne võimekus (VOmax) ja treeningu 
ökonoomsus (kui efektiivselt toimib teie keha jooksmise ajal), ning Running Index on selle mõju 
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mõõtmiseks. Salvestades Running Indexi väärtused aja jooksul, saate te aimu edusammudest. 
Edusammud tähendavad seda, et jooksmiseks kindla tempoga vajate väiksemat pingutust või on 
samasuguse pingutuse juures on jooksutempo kõrgem. Running Index funktsioon suudab need 
edusammud välja arvutada. Running Index annab teile igapäevaselt tagasisidet teie jooksuvõimekuse 
tasemest, mis võib erinevatel päevadel olla erinev. 
 
Running Indexi eelised: 
• Rõhutab heade treeningute ja puhkepäevade positiivset mõju. 
• Võimaldab jälgida kehalise võimekuse ja sooritusvõime muutusi erinevatel südame 

löögisageduse tasemetel – mitte ainult maksimaalse pingutuse tasemel. 
• Teil on võimalik leida enda jaoks optimaalne jooksmise kiirus, kui võrdlete erinevate treeningute 

Running Index väärtusi. 
• Running Index rõhutab jooksutehnika ja kehalise võimekuse tähtsust arengus. 
 
Running Index arvutatakse igal treeningul, mil registreeritakse südame löögisageduse signaal ja 
jooksu kiiruseandurilt* lähtuv signaal ning täidetud on järgnevad tingimused: 
• jooksmise kiirus on suurem kui 6 km/h ja kestus üle 12 minuti; 
• südame löögisagedus ületab 40% maksimaalsest südame löögisagedusest. 
 
Veenduge, et jooksu kiiruseandur on kalibreeritud. Indeksi arvutamine algab treeningu andmete 
salvestamise alustamisel. Treeningu ajal on lubatud peatuda korraks näiteks valgusfoori juures, ilma 
et indeksi arvutamine katkeks. 
 
Lõpus kuvab jooksukompuuter ekraanile Running Indexi väärtuse ja salvestab selle menüüsse File. 
Võrrelge oma tulemust allpool oleva tabeliga. Tarkvara kasutades on teil võimalik jälgida ja 
analüüsida Running Indexi muutusi ajas ja erinevate jooksmise kiiruste puhul. Samuti saate 
analüüsida lühiajalisi ja pikaajalisi muutusi võrreldes erinevate treeningute Running Indexeid. 
 
Lühiajaline analüüs 
 
Running Index Sooritusvõime tase 

<30 Väga madal 
31-37 Madal 
38-44 Rahuldav 
45-51 Keskmine 
52-58 Hea 
59-65 Väga hea 
>65 Suurepärane 

 
On võimalikud päevased kõikumised, mis tulenevad välistest tingimustest, näiteks pinnasest, 
maastikust, tuulest, temperatuurist. 
 
Pikaajaline analüüs 
 
Üksikud Running Index väärtused moodustavad trendi, mis ennustab teie tulemusi teatud vahemaa 
läbimisel. 
 
Allpool olev tabel pakub välja maksimaalse pingutuse korral erinevate distantside läbimise kestuse. 
Kasutage pikema aja jooksul registreeritud Running Indexi keskmiseid väärtusi. Ennustus on 
täpseim, kui Running Index on registreeritud võrreldava vahemaaga võimalikult sarnaste 
tingimuste ja kiiruste puhul. 
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Running 

Index 
Cooperi test 

(m) 
5 km 

(h:mm:ss) 
10 km 

(h:mm:ss) 
21.098 km 
(h:mm:ss) 

42.195 km 
(h:mm:ss) 

36 1900 0:37:30 1:16:00 2:45:00 5:45:00 
38 2000 0:35:00 1:11:30 2:34:00 5:20:00 
40 2100 0:32:30 1:06:30 2:24:00 5:00:00 
42 2200 0:30:45 1:03:00 2:16:00 4:45:00 
44 2300 0:29:00 0:59:30 2:09:00 4:30:00 
46 2400 0:28:00 0:57:30 2:04:00 4:20:00 
48 2500 0:26:45 0:55:00 1:59:00 4:10:00 
50 2600 0:25:30 0:52:30 1:54:00 4:00:00 
52 2700 0:24:15 0:50:00 1:49:00 3:50:00 
54 2850 0:23:15 0:48:00 1:44:00 3:40:00 
56 2950 0:22:15 0:46:00 1:40:00 3:32:00 
58 3100 0:21:15 0:44:00 1:36:00 3:25:00 
60 3200 0:20:30 0:42:30 1:33:00 3:18:00 
62 3300 0:19:30 0:40:30 1:29:00 3:10:00 
64 3400 0:19:00 0:39:30 1:26:00 3:05:00 
66 3500 0:18:30 0:38:30 1:24:00 3:00:00 
68 3650 0:17:45 0:37:00 1:21:00 2:55:00 
70 3750 0:17:15 0:36:00 1:19:00 2:50:00 
72 3900 0:16:30 0:34:30 1:16:00 2:45:00 
74 4000 0:16:00 0:33:30 1:14:00 2:40:00 
76 4100 0:15:30 0:32:30 1:12:00 2:35:00 
78 4200 0:15:15 0:32:00 1:10:00 2:30:00 

 
* Vajalik on lisavarustusena saadaolev jooksu kiiruseandur S1. 
 
Tuleb tähele panna, et lisaks heale Running Indexile on maksimaalse jooksusoorituse jaoks vajalikud 
hea ettevalmistus, optimaalsed tingimused, kiiruslik vastupidavus ja ettevõtlikkus. Seda mõjutavad 
treeningu kvaliteet ja kvantiteet ning ka loomulik anne. 
 
Polar Article Library 
 
Selleks, et teada saada fakte ja näpunäiteid oma jooksusoorituse parandamiseks, külastage Polar 
Article Library artiklite raamatukogu. 
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11. INFO KLIENDITEENINDUSE KOHTA 
 
Hooldus ja korrashoid 
 
Toote eest hoolitsemine 
 
Nagu ka kõiki teisi elektroonikaseadmeid, tuleb ka Polari südame löögisageduse monitori käsitseda 
ettevaatlikult. Allpool olevad soovitused aitavad teil täita omapoolseid garantiikohustusi ning nautida 
toote kasutamist mitme aasta jooksul. 
 
Peale kasutamist ühendage kummipael saatjast lahti. Puhastage saatja vee ja seebiga. Kuivatage 
see käterätiga. Ärge kasutage puhastamiseks alkoholi ega abrasiivseid aineid (terasvilla või 
puhastava toimega kemikaale). 
 
Loputage vööanduri kummipael jooksva vee all peale iga kasutamiskorda. Kui te kasutate 
vööandurit enam kui kolm korda nädalas, peske seda vähemalt kord kolme nädala jooksul 
pesumasinas 40ºC juures. Pesemiseks kasutage pesemiskotti. Ärge leotage kummipaela ning ärge 
kasutage pesuvahendit, mis sisaldab valgendit või pehmendajat. Ärge laske kummipaela keemiliselt 
puhastada ega valgendada. 
 
Enne pikaajalist hoiustamist peske kummipael puhtaks. Peske kummipaela pärast kasutamist 
basseinis, mille vee kloorisisaldus on kõrge. Ärge tsentrifuugige ega triikige kummipaela. Ärge pange 
vööanduri saatjaosa pesumasinasse ega kuivatisse. Kuivatage ja hoiustage vööanduri 
kummipaela ja vööanduri saatjat eraldi. 
 
Hoidke, randmevastuvõtjat, vööandurit ja jooksu kiiruseandurit kuivas ja jahedas kohas. Ärge hoidke 
neid niiskes keskkonnas, õhku mitteläbilaskvast materjalist ümbrises (kilekotis või spordikotis) ega 
koos elektrit juhtivast materjalist asjadega (märg käterätik). Ärge kastke jooksu kiiruseandurit vette. 
Ärge jätke südame löögisageduse monitori osi pikaks ajaks otsese päikesevalguse kätte. 
 
Töötemperatuur on –10ºC kuni +50ºC / +14ºF kuni 122ºF. 
 
Hooldamine 
 
Kaheaastase garantiiperioodi jooksul soovitame teil hooldustööd läbi viia ainult Polari poolt volitatud 
teeninduskeskustes. Garantii alla ei kuulu vigastused ja kahju, mis on tekkinud Polari poolt volitamata 
isikute poolt läbiviidud hooldusest. 
 
Patareide vahetamine 
 
Südame löögisageduse monitori randmevastuvõtja, vööanduri ja jooksu kiiruseanduri* patareide 
vahetamiseks järgige tähelepanelikult juhiseid, mis on antud lõigus Jooksu kiiruseanduri patarei 
paigaldamine. Juhised kehtivad kõigi jooksukompuutri osade patareide vahetamise kohta. 
 
Kui eelistate, et patareivahetuse teostaks Polar, pöörduge palun volitatud teeninduskeskuse poole. 
Patareivahetuse järel viiakse läbi ka perioodiline südame löögisageduse monitori kontroll. 
 
Taustvalgustuse sage kasutamine kiirendab randmevastuvõtja patarei tühjenemist. Patarei 
tühjenemise sümbol  võib ilmuda ekraanile külmades tingimustes ning kaduda taas ekraanilt 
normaalse temperatuuri juurde naasmisel. Selleks, et tagada patareipesa kaane maksimaalne tööiga, 
tohib seda avada vaid patarei vahetamiseks. Patarei vahetamisel veenduge, et tihend ei oleks 
vigastatud. Vigastuste ilmnemisel tuleb tihend asendada uuega. Patarei ja tihendi komplektid on 
saadaval hästivarustatud kauplustes ja Polari teeninduskeskustes. USAs ja Kanadas on tihendid 
saadaval vaid Polari teeninduskeskustes. 
 

 
Hoidke patarei laste käeulatusest väljas. Kui laps neelab patarei alla, võtke viivitamatult 
ühendust arstiga. Patareide hävitamine peab toimuma kooskõlas kohalike ettekirjutustega. 
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* Vajalik on lisavarustusena saadaolev jooksu kiiruseandur S1. 
 
Ettevaatusabinõud 
 
Häired treeningu ajal 
 
Treeningvarustuse poolt põhjustatavad elektromagnetilised häired 
 
Elektromagnetilisi häireid võivad põhjustada kõrgepingeliinid, valgusfoorid, elektri õhuliinid, trammi- ja 
trolliliinid, televiisorid, automootorid, rattakompuutrid, elektrimootoriga treeningvarustus, 
mobiiltelefonid või metallidetektori väravate läbimine. Häiritud näidu ilmnemisel tuleb eemalduda häire 
allikast. 
 
Häireid südame löögisageduse monitori töös võib põhjustada ka treeningvarustus või selle 
elektroonilised või elektrilised komponendid nagu LED-ekraanid, mootorid ja elektrilised pidurid. 
Häirete vältimiseks toimige järgnevalt. 
1. Eemaldage vööandur rindkerelt ja kasutage treeningvarustust nagu tavaliselt. 
2. Liigutage randmevastuvõtjat ringi seni, kuni leiate ala, kus puudub ekraanil väärnäit ning ekraanil 

on 00. Häireid esineb tavaliselt kõige rohkem treeningvarustuse ekraani ees, ekraanist paremal 
ja vasakul pool on suhteliselt häirevaba. 

3. Kinnitage vööandur uuesti ümber rindkere ja hoidke randmevastuvõtja häirevabas alas. 
 
Kui südame löögisageduse monitor ei tööta ikka koos treeningvarustusega, ei sobi viimast koos 
juhtmeta südame löögisageduse monitoriga kasutada. 
 
Ülekoste 
 
Ilma raamita südame sümbol tähistab kodeerimata ülekannet. Kui kasutusel on kodeerimata signaal, 
võtab randmevastuvõtja vastu signaale kõigilt 1 meetri raadiuses olevatelt südame löögisageduse 
vööanduritelt. Samaaegselt välja saadetud kodeerimata ülekandel põhinevad signaalid võivad 
põhjustada ülekostet. 
 
Kui keegi teine südame löögisageduse monitori kasutaja põhjustab häireid, eemalduge sellest isikust 
ja jätkake treeningut nagu tavaliselt. 
 
Järgmiste sammude abil on teil võimalik vältida kellegi teise südame löögisageduse signaali 
registreerimist: 
1. Eemaldage vööandur keha ümbert 30-ks sekundiks. Eemalduge teisest südame löögisageduse 

monitori kasutajast. 
2. Pange vööandur uuesti ümber rindkere ja tooge randmevastuvõtja vööanduril oleva Polari logo 

lähedale. Randmevastuvõtja asub taas otsima südame löögisageduse signaali. Jätkake 
treeningut. 

 
RS400 kasutamine veekeskkonnas 
 
Südame löögisageduse monitori on võimalik kasutada veekeskkonnas. Sellegipoolest, tegemist ei ole 
sukeldumisel kasutatava vahendiga. Veekindluse tagamiseks ärge vajutage randmevastuvõtja nuppe 
vee all. Südame löögisageduse mõõtmisel vees võib tekkida häireid järgmistel põhjustel. 
 
• Suure kloorisisaldusega basseinivesi ja merevesi võivad olla väga hea juhtivusega, põhjustades 

vööanduri elektroodide lühisesse sattumise, mille tagajärjel ei ole vööandur enam võimeline 
EKG-signaale leidma. 

• Vette hüppamisel või jõuliste liigutuste tõttu ujumise ajal võib muutuda vööanduri asukoht ning 
see ei ole enam võimeline EKG-signaali leidma. 
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• EKG-signaali tugevus on indiviiditi erinev, sõltudes kudede koostisest. Südame löögisageduse 

mõõtmisel veekeskkonnas esineb probleeme tunduvalt sagedamini kui selle muude kasutuste 
korral. 

 
Kiiruseandurit Polar S1 võib kasutada niiskes keskkonnas, sealhulgas ka vihma ajal, kuid ta ei ole 
mõeldud kasutamiseks vee all. 
 
Riskide vähendamine treenimisel 
 
Sportimises võib peituda ka teatud ohtusid. Enne treeningprogrammi alustamist on soovitav vastata 
järgmistele küsimustele kontrollimaks teie tervislikku seisundit. Kui vastate kasvõi ühele järgnevatest 
küsimustest positiivselt, soovitame teil enne treeningute alustamist pöörduda konsultatsiooniks arsti 
poole. 
 
• Kas te ei ole regulaarselt harjutanud viimase 5 aasta jooksul? 
• Kas teil on kõrge vererõhk? 
• Kas teil on kõrge verekolesterooli tase? 
• Kas teil on mõne haiguse sümptomeid? 
• Kas te tarvitate vererõhu- või südameravimeid? 
• On teil olnud hingamisprobleeme? 
• Olete te taastumas tõsisest haigusest või ravist? 
• Kas te kasutate südamestimulaatorit või on teil implanteeritud mõni elektrooniline seade? 
• Kas te suitsetate? 
• Kas te olete rase? 
 
Pöörake tähelepanu ka sellele, et südame löögisagedust võivad muuhulgas mõjutada südame-, 
veresoonkonna (eriti kõrgvererõhutõve) ja astma ravimid, samuti mõned ravimid, mida pihustatakse 
hingamisteedesse ning ka energiajoogid, alkohol ja nikotiin. 
 
Tähtis on tähele panna oma organismi reaktsioone sportimise ajal. Kui te tunnete ootamatut valu 
või väsimust, soovitatakse treenimine lõpetada või jätkata väiksema koormusega. 
 
Märkus inimestele, kellele on paigaldatud südamestimulaator, defibrillaator või muu 
elektrooniline seade. Südamestimulaatoriga inimesed võivad südame löögisageduse monitori 
kasutada omal vastutusel. Enne selle kasutuselevõtmist soovitame me arsti järelevalve all läbi viia 
kasutustest selleks, et tagada stimulaatori ja südame löögisageduse monitori kooskasutamise ohutus 
ja usaldusväärsus. 
 
Kui teil on allergia nahaga kokkupuutuvate ainete suhtes või kui te arvate, et toode on 
põhjustanud allergiat, kontrollige, ega need pole märgitud Tehniliste andmete peatükis Polari 
südamelöögisageduse monitoris kasutatavate materjalide nimekirjas. Reaktsiooni ärahoidmiseks 
kandke vööandurit alussärgi peal. Niisutage särki korralikult kohtades, mis jäävad elektroodide alla, et 
tagada südame löögisageduse monitori tõrgeteta töö. 
 
Teie ohutus on meile tähtis. Jooksmise kiiruseanduri kuju on disainitud nii, et see ei jääks jooksmise 
ajal kuhugi kinni. Igatahes peate te olema ettevaatlik kiiruseanduri kasutamisel joostes, eriti siis, kui 
jooksete maastikul, võsas või rägastikus. 
 

 
Niiskuse ja hõõrdumise koostoimel võib vööanduri materjal määrida heledaid riideid. Kui 
kasutate nahal putukatõrjevahendit, peate te kindlustama selle, et putukamürk ei puutu kokku 
vööanduriga. 

 
* Vajalik on lisavarustusena saadaolev jooksu kiiruseandur S1. 
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Tehnilised andmed 
 
Jooksukompuuter 
 
Klass 1 laserseade  
Patarei tööiga: keskmiselt 1 aasta (koormusel 1 tundi päevas, 7 päeva nädalas) 
Patarei tüüp: CR2032 
Patareipesa tihend: O-tihend 20,0 x 1,1, silikoonmaterjalist 
Töötemperatuur: -10°C kuni +50°C / 14°F kuni 122°F 
Kellarihma ja pandla 
materjal: 

Polüuretaan, roostevaba teras 

Tagakaas: Tagakaas on valmistatud polüamiidist ja roostevabast terasest, 
mis vastab EÜ direktiivile 94/27/EU ja selle parandustele 1999/C 
205/05 nikli eraldumisest pikka aega nahaga kokkupuutes 
olevatest toodetest. 

Kella täpsus: parem kui ± 0,5 sekundit päevas temperatuuril +25°C. 
Südame löögisageduse 
mõõtmise täpsus: 

± 1% või ± 1 löök minutis ükskõik missugune on suurem, 
muutumatute tingimuste puhul. 

Südame löögisageduse 
mõõtevahemik: 

15 – 240 lööki minutis 

Liikumiskiiruse näitude 
vahemik: 

Polar S1: 0-29,5 km/h või 0-18,3 miili tunnis 

 
Randmevastuvõtja piirväärtused 
Maksimaalne mällu salvestatavate treeningute arv:  99 
Maksimaalne stopperi näit:  99 h 59 min 59 s 
Maksimaalne mällu salvestatavate ringiaegade arv:  99 
Maksimaalne jalatsitega 1 (Shoes 1) summaarse treeningutel 
läbitud vahemaa näit:  

999999 km / 621370 miili 

Maksimaalne jalatsitega 2 (Shoes 2) summaarse treeningutel 
läbitud vahemaa näit:  

999999 km / 621370 miili 

Maksimaalne summaarse treeningutel läbitud vahemaa näit:  999999 km / 621370 miili 
Maksimaalne summaarse treeningute kestuse näit:  9999h 59min 59s 
Maksimaalne summaarse treeningutel kulutatud kalorite hulga 
näit:  

999 999 kcal 

Maksimaalne summaarse treeningute arvu näit:  9999 
 
Saatja (vööandur) 
WearLink 31 vööanduri 
patarei tööiga: 

keskmiselt 2 aastat (koormusel 1 tund päevas, 7 päeva nädalas). 

Patarei tüüp: CR2025 
Patareipesa tihend: O-tihend 20,0 x 1,0, silikoonmaterjalist 
Töötemperatuur: -10°C kuni +40°C / 14°F kuni 104°F 
Saatja materjal: Polüamiid 
Kummipaela materjal: Polüuretaan, polüamiid, polüester, elastaan ja nailon 
 
Jooksu kiiruseandur S1 
Patarei tööiga:  Keskmiselt 20 kasutustundi 
Patarei tüüp:  Üks AAA patarei 
Töötemperatuur:  -10°C kuni +50°C / 14°F kuni 122°F. 
Täpsus:  ±3 % või parem, peale kalibreerimise läbiviimist, kehtib püsivate 

tingimuste korral. 
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Polar WebLink tarkvara, andmete ülekanne IrDA tehnoloogia abil, Polar ProTrainer 5™ 
Nõuded arvutile: PC-tüüpi arvuti 

Windows® 2000/XP (32bit) 
IrDA-ühilduv infrapunaport (kas sisseehitatud või välise seadmena lisatud) 
Protsessor Pentium II 200MHz või kiirem 
SVGA või parem monitor 
50 MB vaba mahtu kõvakettal 
CD-ROM-lugeja 

 
Polari jooksukompuuter kuvab füsioloogilise pinge määra ja sportimise või treenimise intensiivsuse 
astme. Ekraanile kuvatakse võimekuse näitajaid ja keskkonnaparameetreid nagu kõrgus ja 
temperatuur. Jooksu kiiruseanduri S1 abil on võimalik mõõta jooksmisel läbitud vahemaad ja kiirust, 
samuti on võimalik registreerida jooksusammude sagedust. Teistsugust kasutamist pole ette nähtud 
ega eeldatud. 
 
Polari südame löögisageduse monitori ei tohi kasutada selliste keskkonnaparameetrite mõõtmiseks, 
mille mõõtmisel eeldatakse professionaalset või tööstuslikku täpsust. Lisaks, seadet ei tohi kasutada 
mõõtmiseks veealuse või õhus toimuva tegevuse ajal. 
 
Polari tooted kontrollitakse veekindluse suhtes vastavalt rahvusvahelisele standardile ISO 2281. 
Tooted on jaotatud kolme erinevasse kategooriasse vastavalt veekindlusele. Viite toote veekindluse 
kategooriale leiate te toote tagaküljelt, võrrelge seda allpool tabelis esitatud andmetega. Palun pange 
tähele, et käesolevad märkused ei pruugi kokku langeda teiste tootjate märkustega. 
 
Märgistus 
tagaküljel 

Veepritsmed, 
higi, 
vihmapiisad 
jne. 

Suplemine 
ja ujumine 

Snorgeldamine 
ja sukeldumine 
ilma 
õhuvarudeta 

SCUBA-
sukeldumine 
(õhuvaru 
kaasavõtmisega) 

Veekindluse 
iseloomustus 

Water 
resistant 

X    Pritsmed, 
vihmapiisad jne. 

Water 
resistant, 
50 m 

X X   Minimaalne 
veekindlus 
suplemiseks ja 
ujumiseks* 

Water 
resistant, 
100 m 

X X X  Sagedaseks 
kasutamiseks 
veekeskkonnas, 
kuid mitte süvavee-
sukeldumiseks 

 
* Samad tingimused kehtivad ka Polar WearLink vööanduri kohta, millel on tähistus Water resistant 
30m. 
 
Korduma kippuvad küsimused 
 
Mida ma peaksin tegema, kui ... 
 
... ekraanile ilmub patarei tühjenemise sümbol ja tekst Battery low? 
Patarei tühjenemise sümboli ilmnemine on esimene viide patarei tühjenemise kohta. Patarei 
tühjenemise sümbol võib ekraanile ilmuda ka külmades tingimustes. Sümbol kaob ekraanilt, kui 
naasete normaalse temperatuuri juurde. Kui sümbol ilmub ekraanile, lülituvad välja helisignaalid ja 
taustvalgustus. Lisainfo patarei vahetamise kohta leiate lõigust Hooldus ja korrashoid. 
 
... ma ei tea, kus ma menüüdes asun? 
Vajutage ja hoidke all nuppu STOP, kuni jooksukompuuter naaseb kellaajarežiimi. 
 
... jooksukompuuter ei reageeri nupuvajutustele? 
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Teostage jooksukompuutrile alglaadimine, vajutades ja hoides all kõiki nuppe kahe sekundi jooksul, 
kuni ekraanile ilmuvad kõik sümbolid. Vajutage ükskõik millist nuppu ja seadistage alglaadimise järel 
põhiseadistustest kellaaeg ja kuupäev. Kõik muud seadistused jäävad alles. Võite ülejäänud 
seadistused vahele jätta vajutades ja hoides all nuppu STOP. 
 
... südame löögisageduse näit on hüplik, äärmiselt kõrge või langeb nulli (00)? 
• Kontrollige, kas randmevastuvõtja on vööandurist alla 1 meetri kaugusel. 
• Kontrollige, et elastne kummipael ei oleks treenimise käigus lõdvenenud. 
• Veenduge, et tekstiilelektroodid oleksid tihedalt ümber rindkere. 
• Kontrollige, et vööanduri elektroodid / riietuse elektroodid oleksid niisked ja et te kannaksite 

vööandurit nagu juhendatud. 
• Kontrollige, kas vööandur/riietus on puhas ja vigastamata. 
• Veenduge, et ülekanderaadiuses (1 m) ei oleks teisi südame löögisageduse monitore.  
• Tugevad elektromagnetilised signaalid võivad põhjustada korrapäratuid näite. Lisainfot leiate 

peatükist Ettevaatusabinõud. 
• Kui korrapäratud südame löögisageduse näidud jäävad ekraanile vaatamata võimalikust häirete 

allikast eemaldumisele, vähendage kiirust ja kontrollige pulssi käsitsi. Kui te tunnete, et see 
vastab kõrgele südame löögisageduse näidule ekraanil, võib teid olla tabanud arütmiahoog. 
Kuigi enamus arütmiaid on ohutud, konsulteerige oma arstiga. 

• Põetud südamehaigus võib olla muutnud teie EKG-d. Sellisel juhul konsulteerige oma arstiga. 
 
... ekraanile ilmub Memory full? 
Selline teade ilmub ekraanile, kui olete salvestanud 99 ringiaega või on saanud täis treeningu 
andmete salvestamiseks mõeldud mälu. Sellisel juhul lõpetage treeningu andmete salvestamine ja 
kandke treeningufailid Polar ProTrainer 5 tarkvarasse. Seejärel kustutage need jooksukompuutri 
mälust. 
 
... ekraanile ilmub Check WearLink! ning jooksukompuuter ei suuda leida südame 
löögisageduse signaali? 
• Kontrollige, kas randmevastuvõtja on vööandurist alla 1 meetri kaugusel. 
• Kontrollige, et elastne kummipael ei oleks treenimise käigus lõdvenenud. 
• Veenduge, et riietuse tekstiilelektroodid oleksid tihedalt ümber rindkere. 
• Kontrollige, et vööanduri elektroodid / riietuse elektroodid oleksid niisked. 
• Kontrollige, et vööanduri / riietuse elektroodid oleksid puhtad ja vigastamata. 
• Kui südame löögisageduse registreerimine ei toimi spordiriietusega, proovige südame 

löögisagedust mõõta elastses kummipaelas olevate elektroodide abil. Kui see õnnestub, on viga 
tõenäoliselt spordiriietuses. Palun võtke ühendust spordiriietuse müüja või valmistajaga. 

• Kui te olete läbi proovinud eelnevalt kirjeldatud soovitused ja teil ei õnnestu südame 
löögisageduse mõõtmine, võib põhjuseks olla vööanduri patarei tühjenemine. Lisainfo leiate 
peatükist Hooldus ja korrashoid. 

 
... ekraanile ilmub Check Footpod! ja jooksukompuuter ei registreeri kiiruse ja vahemaa 
signaali?* 
 
• Veenduge, et jooksu kiiruseanduri funktsioon on jooksukompuutris sisse lülitatud. Kui on, siis 

peaks ekraanile ilmuma jooksja sümbol. 
• Veenduge, et jooksu kiiruseandur on sisse lülitatud, milleks on vaja vajutada ja hoida all punast 

nuppu. 
• Kui üritate jooksu kiiruseandurit sisse lülitada ja kas vilgub punane tuli või ei vilgu tuli üldse, tuleb 

vahetada jooksu kiiruseanduri patarei. Lisainfo leiate lõigust Jooksu kiiruseanduri patarei 
paigaldamine. 

• Kui te hoiate jooksukompuutrit enda ees enam kui 15 sekundi jooksul, peatub kiiruse ja 
vahemaa andmete mõõtmine. Taasalustage mõõtmist käe liigutamisega. 

• Kui jooksete jooksurajal ja olete kinnitanud jooksukompuutri enda ees olevale rõhttorule, 
liigutage jooksukompuutrit külje poole. 
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... ekraanile ilmub Footpod calibration failed? 
Kalibreerimine ei õnnestunud ja te peate uuesti kalibreerima. Kalibreerimine ebaõnnestub, kui liigute 
kalibreerimise ajal. Kui olete ringi lõpetanud, lõpetage jooksmine ja püsige liikumatult. Käsitsi 
kalibreerimisel on kalibreerimisvahemik 0.500 kuni 1.500. Kui seate faktori väljapoole seda 
vahemikku, kalibreerimine ebaõnnestub. 
 
... ekraanile ilmub Memory low? 
Memory low ilmub ekraanile, kui treeningute salvestamiseks on vaba mälu jäänud alla 1 tunni. 
Selleks, et maksimaalselt ära kasutada vaba mälumahtu, valige menüüst Settings > Features > 
Rec.rate pikim andmete salvestamisintervall, 60 sekundit. Kui mälumaht saab täis, ilmub ekraanile 
Memory full. Mälu vabastamiseks kandke treeningud üle Polar ProTrainer 5 tarkvarasse ja kustutage 
need jooksukompuutri mälust. 
 
* Vajalik on lisavarustusena saadaolev jooksu kiiruseandur S1. 
 
Polari piiratud rahvusvaheline garantii 
 
• Neile, kes ostsid selle toote USAs või Kanadas, on Polari piiratud rahvusvahelise garantii 

andjaks Polar Electro Inc. Neile, kes ostsid selle toote teistes riikides, on Polari piiratud 
rahvusvahelise garantii andjaks Polar Electro Oy. 

• Käesolevaga garanteerib Polar Electro Oy selle jooksukompuutri esmaostjale, et tootel ei esine 
tootmis- ega materjalivigu 2 (kahe) aasta jooksul ostukuupäevast. 

• Palun hoidke alles ostutšekk või täidetud rahvusvaheline garantiikaart, see on ostu 
tõenduseks! 

• Garantii ei kata patarei tühjenemist, vigu, mis tulenevad ebaõigest kasutamisest, 
õnnetusjuhtumitest või ettevaatusabinõude eiramisest ning ebaõigest hooldusest; 
kommertskasutusest, samuti südame löögisageduse monitori mõranemist või purunemist ja 
elastse kummipaela purunemist. 

• Garantii ei kata kahjusid, kahjustusi, kahjumit, kulusid ja väljaminekuid, olgu need otsesed, 
kaudsed, juhuslikud või järelduslikud, mis tulenevad või on seotud tootega. Garantiiperioodi 
vältel toode kas parandatakse või asendatakse tasuta Polari teeninduskeskuse poolt. 

• Garantii ei mõjuta tarbija kohalikel seadustel põhinevaid õigusi ega tarbija ostu-müügi lepingust 
tulenevaid õigusi edasimüüja suhtes. 

 

 
See toode vastab direktiivile 93/42/EEC ja 1999/5/EC. Asjakohased vastavusdeklaratsioonid asuvad 
aadressil www.support.polar.fi/declaration_of_conformity.html. 
 

 

Selline läbikriipsutatud prügikasti kujutis tähendab, et Polari tooted on 
elektroonikaseadmed ning neid hõlmavad Euroopa Parlamendi ja Nõukogu 
elektriliste ja elektrooniliste jäätmete direktiiv 2002/96/EC (WEEE). Euroopa Liidu 
riikides tuleb need tooted muudest jäätmetest eraldada. Polar julgustab teid 
vähendama võimalikku kahju keskkonnale ja tervisele ka väljaspool Euroopa Liitu 
järgides kohalikke jäätmemajanduse korraldamist puudutavaid seadusi ning 
võimaluse korral hävitades elektroonilisi seadmeid olmeprügist eraldatuna. 

 
Copyright © 2006 Polar Electro Oy, FIN-90440 KEMPELE, Finland. 
 
Polar Electro Oy vastab ISO 9001:2000 tingimustele. 
 
All rights reserved. No part of this manual may be used or reproduced in any form or by any means 
without prior written permission of Polar Electro Oy. The names and logos marked with a™symbol in 
this user manual or in the package of this product are trademarks of Polar Electro Oy. 
 

 56

The names and logos marked with a ® symbol in this user manual or in the package of this product 
are registered trademarks of Polar Electro Oy, except Windows which is a registered trademark of 
Microsoft Corporation. 
 
Polari disclaimer 
 
• Materjal selles kasutusjuhendis on esitatud puhtalt informeerimise eesmärgil. Tooted ja 

omadused, mida selles kirjeldatakse, võivad muutuda ilma etteteatamiseta tootjapoolse pideva 
arendustegevuse tõttu. 

• Polar Electro OY / Polar Electro Inc. ei tee mingeid kinnitusi ega anna garantiisid selle 
kasutusjuhendi ega selles mainitud toodete alusel. Polar Electro Oy ei vastuta ei otsese ega 
kaudse, juhusliku ega süülise kahju eest, mis tuleneb või on seotud selle infomaterjali või selles 
kirjeldatud toodete kasutamisest. 

• Polar Electro OY / Polar Electro Inc. ei vastuta kahjude, kahjustuste, kahjumi, kulude ja 
väljaminekute eest, olgu need otsesed, kaudsed, juhuslikud või järelduslikud, mis tulenevad või 
on seotud käesoleva materjaliga või selles kirjeldatud toodetega. 

 
Seda toodet kaitsevad järgmised patendid: 
US 5486818, GB 2258587, HK 306/1996, WO96/20640, EP 0748185, US6104947, EP 0747003, 
US5690119, DE 69630834.7-08, WO 97/33512, US 6277080, EP 0984719, US 6361502, EP 
1405594, US 6418394, EP 1124483, US 6405077, US 6714812, US 6537227, FI 114202, US 
6666562 B2, US 5719825, US 5848027, EP 1055158, FI 113614, FI23471, USD49278S, 
USD492784S, USD492999S, FI68734, US4625733, DE3439238, GB2149514, HK81289, FI88972, 
US5486818, DE9219139.8, GB2258587, FR2681493, HK306/1996, FI96380, WO95/05578, 
EP665947, US5611346, JP3568954, DE69414362, FI4150, US6477397, DE20008882, FR2793672, 
ES1047774, FI112844, EP 724859 B1, US 5628324, DE 69600098T2, FI110915. Teised patendid on 
taotlemisel. 
 
Tootja: 
Polar Electro Oy 
Professorintie 5 
FIN-90440 Kempele 
FINLAND/SOOME 
Telefon +358 8 5202 100 
Faks + 358 8 5202 300 
www.polar.fi 
 
Maaletooja: 
 
AS Mefo 
Uku tänav 4 
Tallinn 
10918 
Eesti Vabariik 
 
Telefon 670 7077 
Faks 670 7078 
E-mail: mefo@mefo.ee 
http://www.mefo.ee 
Käesolev kasutusjuhend on tõlgitud ja täiendatud Erik Landõri poolt 6. märtsil 2007. aastal.  


